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About This Guide

This Novell® GroupWise® 6.5 Cross-Platform Client User Guide explains how to use GroupWise 
on Linux* or MacIntosh*. The guide is divided into the following sections:

“Getting Started” on page 11
“Logging In to GroupWise” on page 23
“Working with Items in Your Mailbox” on page 27
“Scheduling Group and Posted Items” on page 43
“Using Your Calendar” on page 51
“Managing Your Mailbox” on page 55
“Using the Address Book” on page 71
“Using Caching Mode” on page 83
“Customizing GroupWise” on page 87

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 6.5 
documentation Web site (http://www.novell.com/documentation/gw65):

Installation Guide

Administration Guide

Multi-System Administration Guide 

Interoperability Guide

Troubleshooting Guides

GroupWise WebAccess Client User Guide

GroupWise Cross-Platform Client User Guide

Documentation Updates

For the most recent version of the GroupWise 6.5 Cross-Platform Client User Guide, visit the 
Novell GroupWise 6.5 documentation Web site (http://www.novell.com/documentation/gw65).

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.
About This Guide 9
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User Comments

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.
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1 Getting Started

GroupWise® is a robust, dependable messaging and collaboration system that connects you to your 
universal mailbox anytime and anywhere. This section gives you an introductory overview of the 
GroupWise client to help you start using the GroupWise Cross-Platform client quickly and easily.

“Starting the GroupWise Cross-Platform Client” on page 11

“Getting Acquainted with the Main GroupWise Window” on page 12

“Using Different GroupWise Modes” on page 16

“Understanding Your Mailbox” on page 17

“Using the Toolbar” on page 19

“Using Shortcut Keys” on page 19

“Learning More” on page 21

Starting the GroupWise Cross-Platform Client
To begin using GroupWise, you or your system administrator must install GroupWise on your 
computer. You can run the Cross-Platform client on Linux or Macintosh workstations.

“Setting Up the GroupWise Cross-Platform Client on Linux” on page 11

“Setting Up the GroupWise Cross-Platform Client on Macintosh” on page 12

Setting Up the GroupWise Cross-Platform Client on Linux
1 Open a new terminal window, then enter the following command:

xhost + localhost

2 In the same window, become root by entering su and the root password.

3 Change to the root of the GroupWise 6.5 for Linux Cross-Platform Client CD.

4 Enter ./install.

5 Select the language in which you want to run the Installation Advisor and install the Cross-
Platform client software, then click OK.

6 In the Installation Advisor, click Install Products > Install GroupWise Client.

7 When the installation is complete, click OK.

For your convenience, a GroupWise  icon is automatically created on your desktop.

8 To start GroupWise, click the GroupWise  icon.

9 Specify the username, password, and server information, then click OK.
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Setting Up the GroupWise Cross-Platform Client on Macintosh
1 Browse to the GroupWise.app.sit file on the GroupWise 6.5 for Linux Cross-Platform Client 

CD.

2 Double-click the GroupWise.app.sit file to install the Cross-Platform client software.

The installation process adds a GroupWise  icon to your desktop.

3 To start GroupWise, double-click the GroupWise icon  to start the Cross-Platform client.

4 Specify the username, password, and server information, then click OK.

Getting Acquainted with the Main GroupWise Window
Your main work area in GroupWise is called the Main Window. From the Main Window of 
GroupWise, you can read your messages, schedule appointments, view your Calendar, manage 
contacts, change the mode of GroupWise you’re running in, open folders, open documents, and 
much more.

You can open more than one Main Window in GroupWise by clicking Window, then clicking New 
Main Window. This is useful if you proxy for another user. You can look at your own Main 
Window and the Main Window belonging to the person you are proxying for. You might also want 
to open a certain folder in one window and look at your Calendar in another. You can open as many 
Main Windows as your computer’s memory allows.

The basic components of the Main Window are explained below.

Folder List
Folder and Item 

List Header
Toolbar

Quick Viewer Item List
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Toolbar
The toolbar lets you quickly accomplish common GroupWise tasks, such as opening the Address 
Book, sending mail messages, and finding an item. For information about the toolbar, see “Using 
the Toolbar” on page 19.

Folder and Item List Header
The Folder and Item List header provides a drop-down list where you can select the mode of 
GroupWise you want to run (Online, Caching), select to open your archived or backup mailbox, 
and select a proxy mailbox. For information about these features, see “Using Different GroupWise 
Modes” on page 16, “Archiving the Items in Your Mailbox” on page 61, and “Giving Other People 
Access to Your Mailbox” on page 63.

Folder List
The Folder List at the left of the Main Window lets you organize your GroupWise items. You can 
create new folders to store your items in. Next to any folder (except for shared folders), the number 
of unread items is shown in square brackets. Next to the Sent Items folder, the number in square 
brackets shows how many items are pending to be sent from Caching mode. For information about 
the different GroupWise folders, see “Using the Folder List” on page 55.

If you want, you can close your folder list to leave more room for other views, such as the 
Calendar, in the Main Window. Click View, then click Folders List to open or close the Folder List 
display. 

Here is what you’ll find in each of the default folders:

“User Folder” on page 13

“Mailbox Folder” on page 13

“Sent Items Folder” on page 14

“Calendar Folder” on page 14

“Contacts Folder” on page 14

“Checklist Folder” on page 14

“Documents Folder” on page 15

“Cabinet Folder” on page 15

“Trash Folder” on page 15

“Shared Folders” on page 15

User Folder

Your user folder  (indicated by your name) represents your GroupWise database. All folders in 
you Main Window are subfolders of your user folder.

Mailbox Folder

The Mailbox  displays all the items you have received, with the exception of scheduled items 
(appointments, tasks, and reminder notes) you have accepted or declined. Accepted scheduled 
items are moved to the Calendar. 
Getting Started 13
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Sent Items Folder

The Sent Items folder  displays all sent items from the Mailbox and Calendar. The Sent Items 
folder in versions prior to GroupWise 6.5 was a query folder, which had some differences from the 
current Sent Items folder.

The following is a comparison between the previous Sent Items query folder and the current Sent 
Items folder.

Calendar Folder

The Calendar folder  shows several calendar view options. 

Contacts Folder

The Contacts folder , by default, represents the Frequent Contacts address book in the Address 
Book. Any modification you make in the Contacts Folder is also made in the Frequent Contacts 
address book.

From this folder, you can view, create and modify contacts, resources, organizations and groups.

Your proxies never see your Contacts folder.

Checklist Folder

Use the Checklist folder  to create a task list. You can move any items (mail messages, phone 
messages, reminder notes, tasks, or appointments) to this folder and arrange them in the order you 
want. Each item is marked with a check box so that you can check items off as you complete them. 

The following is a comparison between the Checklist folder and the Task List query folder (found 
in previous versions of GroupWise).

Sent Items Folder (Current) Sent Items Query Folder (Previous)

All sent items reside in this folder unless they are 
moved to a folder other than the Mailbox or 
Calendar. If a sent item is moved to another 
folder, it no longer displays in the Sent Items 
folder.

No items actually reside in this folder. This folder is 
a Find Results folder, which means a Find is 
performed when you click the folder and the results 
of the Find (all sent items) are displayed in the 
folder. If you delete an item from this folder, the 
original item remains in its original folder and 
redisplays the next time you open this folder.

You can resend, reschedule, and retract sent 
items from this folder.

You can resend, reschedule, and retract sent items 
from this folder.

Checklist Folder Task List Folder

This folder contains the following items:

Items you have moved to this folder

Items you have posted to this folder

Items that are part of a checklist that you 
have created in another folder

No items actually reside in this folder. This folder is a 
Find Results folder, which means a Find is performed 
when you click the folder and the results of the Find 
(all scheduled tasks) are displayed in the folder. If 
you delete an item from this folder, the original item 
remains in its original folder and redisplays the next 
time you open this folder.

Any item type can reside in this folder. Only tasks show in this folder. Tasks are scheduled 
items that are associated with a due date.
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Documents Folder

Your document references are organized in the Documents folder  so you can locate them easily. 

The Documents folder can contain only documents. If any other type of item is moved to this 
folder by a GroupWise client older than version 5.5, the item is deleted.

Cabinet Folder

The Cabinet  contains all your personal folders. You can rearrange and nest folders by clicking 
Edit, then clicking Folders. You can change how the folders are sorted by right-clicking the 
Cabinet folder, clicking Properties, then selecting what you want to sort by.

Trash Folder

All deleted mail and phone messages, appointments, tasks, documents, and reminder notes are 
stored in the Trash folder . Items in the Trash can be viewed, opened, or returned to your Mailbox 
before the Trash is emptied. (Emptying the Trash removes items in the Trash from the system.) 

You can empty your entire Trash, or empty only selected items. You can empty the Trash manually. 
The system administrator can specify that your Trash is emptied automatically on a regular basis.

Shared Folders

A shared folder  is like any other folder in your Cabinet, except other people have access to it. 
You can create shared folders or share existing personal folders in your Cabinet. You choose whom 
to share the folder with, and what rights to grant each user. Then, users can post messages to the 
shared folder, drag existing items into the folder, and create discussion threads. You can’t share 
system folders, which include the Cabinet, Trash, and Work In Progress folders.

Item List
The Item List on the right side of the Main Window displays your mail and phone messages, 
appointments, reminder notes, tasks, and document references. You can sort the Item List by 
clicking a column heading. To reverse the sort order, click the column heading a second time. For 
information about the icons used with different items, see “Icons Appearing Next to Items in Your 
Mailbox and Calendar” on page 17.

To mark an item completed, click the check box 
next to the item in the Item List.

To mark an item completed, open the item, then click 
Completed.

Due dates are set by the person who sent you the 
task. If you post a task for yourself, you can set a due 
date.

To set the priority of an item, open the item, then type 
a priority in the Priority field.

Checklist items do not display in the Task List 
of the Calendar.

Tasks display in the Task List of the Calendar and 
can be marked Completed from the Calendar.

Tasks that are past due show as red in the Calendar.

Checklist Folder Task List Folder
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QuickViewer
The QuickViewer opens below the Folder and Item List. You can quickly scan items and their 
attachments in the QuickViewer rather than open each item in another window. For information 
about the QuickViewer, see “Reading Items in the QuickViewer” on page 36.

Using Different GroupWise Modes
GroupWise provides two different ways to run the GroupWise client: Online mode and Caching 
mode.

You might be able to run GroupWise in either mode, or your system administrator might require 
that you use only a certain mode.

Most GroupWise features are available in all both GroupWise modes, with some exceptions. 
Subscribing to other users’ notifications is not available in Caching mode.

Online Mode
When you use Online mode, you are connected to your post office on the network. Your mailbox 
displays the messages and information stored in your network mailbox (also called your Online 
Mailbox). Online mode is connected to your network mailbox continuously. In Online mode, if 
your Post Office Agent shuts down or you lose your network connection, you temporarily lose 
your connection to your mailbox.

You should use this mode if you do not have a lot of network traffic, or if you use several different 
workstations and do not want to download a local mailbox to each one. 

Caching Mode
Caching mode stores a copy of your network mailbox, including your messages and other 
information, on your local drive. This allows you to use GroupWise whether or not your network 
or Post Office Agent is available. Because you are not connected to the network all the time, this 
mode cuts down on network traffic and has the best performance. A connection is made 
automatically to retrieve and send new messages. All updates are performed in the background so 
your work is not interrupted. 

To use Caching mode, the client installation must be a standard installation, not a workstation 
installation.

You should use this mode if you have enough disk space on your local drive to store your mailbox. 

Several users can set up their Caching Mailboxes on a single shared computer.

If you run Caching Mode and Remote Mode on the same computer, the same local mailbox (also 
called the Caching Mailbox or Remote Mailbox) can be used to minimize disk space usage. 

If disk space is limited, you can restrict the items that are downloaded to your local mailbox. You 
can specify to get the subject line only or specify a size limit.

For more information about setting up Caching Mode, see Chapter 8, “Using Caching Mode,” on 
page 83.
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Understanding Your Mailbox
All of your items, whether you send or receive them, are stored in your GroupWise Mailbox. You 
can quickly display only received items, sent items, posted items, or draft items by clicking a 
setting on the Display drop-down list. You can further restrict which items display in your Mailbox 
by using filters. See Chapter 6, “Managing Your Mailbox,” on page 55 for more information.

You can organize your messages by moving them into folders within your Cabinet, and you can 
create new folders as necessary. See “Using the Folder List” on page 55 for more information.

You can also organize your messages by assigning them categories. Each category displays as a 
different color in your Mailbox. You can filter on categories. 

Bolded Items in Your Mailbox
All unopened items in your Mailbox are bolded to help you easily identify which items and 
documents you have not yet read. The icon appearing next to an item also indicates if it is 
unopened.

Collapsed discussion threads are marked with bold text if there are items in the thread that are 
unread. This saves you the time of expanding each thread to check if there are newly posted items.

Sent items are also bolded to show when they are queued but not uploaded, status information has 
not been received about the item being delivered, or they have not yet been transferred to the 
Internet.

Icons Appearing Next to Items in Your Mailbox and Calendar
The icons that appear next to items in your Mailbox and Calendar show information about the 
items. The following table explains what each icon means.

Icon Description

Next to an item you have sent in Caching mode, the  icon indicates that the item 
has been queued, but the queue has not been uploaded. After the item has been 
uploaded, this icon indicates that status information has not been received about the 
item being delivered to the destination post office or transferred to the Internet.

Next to the Sent Items folder, the  icon indicates that there is at least one item that 
has been queued but has not been uploaded.

Appears next to an item you have sent. If the item has been opened by at least one 
person, this icon appears until all recipients have 1) opened the mail, phone 
message, or reminder note; 2) accepted the appointment; or 3) completed the task.

Appears next to an item you have sent. The item couldn't be delivered to the 
destination post office or it failed to transfer to the Internet.

Appears next to an item you have sent. Next to an appointment or task, this icon 
indicates that at least one person has declined/deleted the item. Next to a mail 
message, phone message, or reminder note, this icon indicates that at least one 
person has deleted the item without opening it.

One or more attachments are included with the item.
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One or more sound annotations are included with the item, or the item is a voice mail 
message.

Draft item.

Appears next to an item you have sent.

Appears next to an item you have replied to.

Appears next to an item you have forwarded.

Appears next to an item you have delegated.

Appears next to an item you have replied to and forwarded

Appears next to an item you have replied to and delegated.

Appears next to an item you have forwarded and delegated.

Appears next to an item you have replied to, forwarded, and delegated

Posted item.

Specific version of a document.

Official version of a document.

Unopened mail message with a low, standard, or high priority.

Opened mail message with a low, standard, or high priority.

Unopened appointment with a low, standard, or high priority.

Opened appointment with a low, standard, or high priority.

Unopened task with a low, standard, or high priority.

Opened task with a low, standard, or high priority.

Unopened reminder note with a low, standard, or high priority.

Opened reminder note with a low, standard, or high priority.

Unopened phone message with a low, standard, or high priority.

Opened phone message with a low, standard, or high priority.

The sender has requested that you reply to this item. The item can be a low, standard, 
or high priority.

Icon Description
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Using the Toolbar
Use the toolbar to access many of the features and options found in GroupWise. The toolbar at the 
top of a folder or item is context sensitive; it changes to provide the options you need most in that 
location.

Using Shortcut Keys
You can use a number of shortcut keys in GroupWise for accessibility or to save time when you 
perform various operations. The table below lists some of these keystrokes, what they do, and the 
context where they work.

Appears in a Busy Search. If it appears to the left of a username or resource, you can 
click a scheduled time across from the username or resource on the Individual 
Schedules tab to display more information about the appointment in the box below. 
However, the user or resource owner must give you appointment Read rights in the 
Access List before this icon appears. See “Adding and Removing Proxy Names and 
Rights in Your Access List” on page 64.

Appears on your Calendar, indicates an alarm is set for the item.

Appears on your Calendar, indicates the item is a group appointment, reminder note, 
or task.

Appears on your Calendar, indicates the item is marked private.

Appears on your Calendar, indicates that you declined the item but didn’t delete it.

Keystroke Action Where It Works

F1 Open online help Main Window, Calendar, item, dialog box

F5 Refresh the view Main Window, Calendar

Ctrl+A Select all items; select all text Item List; text

Ctrl+B Bold text In text

Ctrl+C Copy selected text In text

Ctrl+F Open the Find dialog box Main Window, Calendar, item, dialog box

Ctrl+I Italicize text In text

Ctrl+M Open a new mail message Main Window, Calendar, item, dialog box

Ctrl+O Open the selected message Item List

Ctrl+P Open the Print dialog box Main Window, item

Ctrl+Q Turn the QuickViewer on and off Main Window, Calendar

Ctrl+R Mark the selected item unread Item List

Icon Description
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Ctrl+S Save a draft in the Work in Progress 
folder

In an item

Ctrl+U Underline text In text

Ctrl+V Paste selected text In text

Ctrl+X Cut selected text In text

Ctrl+Z Undo the last action In text

Ctrl+Enter Open the selected item Item List

Ctrl+Shift+Left-arrow

or

Ctrl+Shift+Right-
arrow

Select text one word at a time In text

Ctrl+Shift+A Open a new appointment Main Window, Calendar, item, dialog box

Ctrl+Shift+T Open a new task Main Window, Calendar, item, dialog box

Ctrl+Shift+R Open a new reminder note Main Window, Calendar, item, dialog box

Ctrl+Shift+P Open a new phone message Main Window, Calendar, item, dialog box

Alt+F4 From the Main Window or 
Calendar, exit GroupWise.

From an item, exit the item.

From a dialog box, exit the dialog 
box.

Main Window, Calendar, item, dialog box

Alt + [letter] Activate the menu bar (Use the 
underlined letters in the menu 
names)

Main Window, Calendar, item

Alt+Enter Display the properties of the 
selected item

Item List

Shift+Left-arrow

or

Shift+Right-arrow

Select text one character at a time In text

Shift+End

or

Shift+Home

Select text to the end or beginning 
of a line

In text

Shift + [letter] In the Folder List, Shift + the first 
letter of a subfolder name goes to 
the subfolder.

Folder list

Tab Cycle through fields, buttons, and 
areas

Main Window, Calendar, dialog box, item

Keystroke Action Where It Works
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Learning More
You can learn more about GroupWise from the following resources:

“Online Help” on page 21

“GroupWise 6.5 Documentation Web Page” on page 21

“GroupWise Cool Solutions Web Community” on page 21

Online Help
Complete user documentation is available in Help. In the Main Window, click Help, click Help 
Topics, then use the Contents tab, Index tab, or Search tab to locate the help topics you want. 

In order to use Help with the GroupWise client, you must have Internet Explorer 4.x or higher 
installed.

GroupWise 6.5 Documentation Web Page
For this user guide and extensive GroupWise administration documentation, go to the GroupWise 
6.5 area on the Novell Documentation (http://www.novell.com/documentation/lg/gw65/docui/
index.html) Web site.

This user guide is also available from the GroupWise client by clicking Help, then clicking User’s 
Guide.

GroupWise Cool Solutions Web Community
At GroupWise Cool Solutions, you’ll find tips, tricks, feature articles, and answers to frequent 
questions. In the Main Window, click Help, then click Cool Solutions Web Community or go to 
http://www.novell.com/coolsolutions/gwmag (http://www.novell.com/coolsolutions/gwmag).

Shift+Tab Reverse the order of cycling 
through fields, buttons, and areas

Main Window, Calendar, dialog box, item

Ctrl+Tab In text, indent the text.

In a tabbed dialog box, open the 
next tab.

In text, dialog box

Ctrl+Enter Send the item. Main Window, item

Keystroke Action Where It Works
Getting Started 21

http://www.novell.com/documentation/lg/gw65/docui/index.html
http://www.novell.com/coolsolutions/gwmag


    Novell Confidential                                                                                            Manual (99a)  21 December 2004
22   GroupWise 6.5 Cross-Platform Client User Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
2 Logging In to GroupWise

This section tells you about GroupWise® login options and GroupWise passwords.

“Logging In to GroupWise” on page 23

“Assigning Passwords to Your Mailbox” on page 25

Logging In to GroupWise
When you start GroupWise, you might be prompted to type information such as your password, 
the TCP/IP address of your post office agent, and so forth. This Startup dialog box changes, 
depending on the information GroupWise needs to be able to open your Mailbox, and the 
GroupWise mode that you log in to. 

Your system administrator might restrict the GroupWise modes you can log in to.

“Logging In to Your Mailbox” on page 23

“Logging In to Your Mailbox from Another User’s Workstation” on page 23

Logging In to Your Mailbox
1 Start GroupWise.

If you have not specified a password for your Mailbox and GroupWise needs no additional 
information, you bypass the Startup dialog box and GroupWise is displayed.

To force the GroupWise Startup dialog box to be displayed on Linux, right-click the 
GroupWise icon on the desktop, click Properties, then click the Execute tab. In the Command 
field after the GroupWise executable name, type a space, type -@u=?, then click OK.

For information about other startup options, see “Using Startup Options” on page 90.

2 If you are prompted for a password, type the password in the Password box.

3 Click the mode of GroupWise you are logging in to and type additional necessary information, 
such as the path to the post office, the TCP/IP address and port of the post office agent, and 
the path to your Caching mailbox.

If you do not know the required information, contact your system administrator.

4 Click OK.

Logging In to Your Mailbox from Another User’s Workstation
You must be on the same post office as the other user to log into your own Mailbox from his or 
her workstation.

1 Log in to the network with your own user ID.
Logging In to GroupWise 23



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
or

To force the GroupWise Startup dialog box to be displayed on Linux, right-click the 
GroupWise icon on the desktop, click Properties, then click the Execute tab. In the Command 
field after the GroupWise executable name, type a space, type -@u=?, then click OK.

2 Start GroupWise.

3 Type your user ID in the User ID field.

4 Click the Password field, type your password, then click OK.

Logging in to Your Mailbox from a Shared Workstation
If you use the same workstation for multiple people, it is highly recommended that each user have 
a seperate log in for the workstation. When GroupWise saves the display settings for a user they 
are saved to the current user’s registry. This allows GroupWise to display the settings for the user 
that is currently logged in to the workstation. This allows you to customize GroupWise the way 
you want it to look without changing the look for other users. 

When a user is done using the workstation, that user should log out of the workstation completely. 
This allows the next user to log on to the system with their GroupWise settings.

However, there are special circumstances when having a different log on for each user on the 
workstation is not a viable option. In these cases there are a couple of steps you should perform to 
setup GroupWise properly. 

“Using the Login Screen Startup Switch” on page 24

“Using Notify On a Shared Workstation” on page 24

Using the Login Screen Startup Switch

For the login screen startup switch to work properly, you must be on the same post office as the 
other user to log into your own Mailbox from his or her workstation.

1 Right-click the GroupWise icon on the desktop, click Properties, click the Shortcut tab, in the 
Target box, after the GroupWise executable, type a space, type /@u-?, then click OK.

2 Start GroupWise.

3 Type your user ID in the User ID box.

4 Click the Password box, type your password, then click OK.

Using Notify On a Shared Workstation  

To use Notify on a shared workstation, you need to configure Notify to start when GroupWise is 
opened.

1 In GroupWise, click Tools > Options, then double-click Environment.

2 On the General page, select Start Notify at Startup.

This starts Notify when GroupWise starts and closed Notify when GroupWise is closed.

3 Click OK, then click Close.
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Assigning Passwords to Your Mailbox
You can assign a password to your Mailbox. GroupWise passwords are case sensitive (for 
example, Wednesday is not the same as WEDNESDAY). If you forget your password, you cannot 
access any of your items. 

“Adding, Changing, and Removing Your Password” on page 25

Adding, Changing, and Removing Your Password
“Adding a Password” on page 25

“Changing Your Password” on page 25

“Removing Your Password” on page 25

Adding a Password

1 In the Main Window, click Tools, then click Options.

2 Click Security, then click the Password tab. 

3 In the New Password text field, type the password.

4 In the Confirm New Password text field, type the password, click OK, then click Close.

Changing Your Password

1 In the Main Window, click Tools, then click Options.

2 Click Security, then click the Password tab.

3 In the Old Password text field, type the password you want to change, then press the Tab key.

4 In the New Password text field, type the new password.

5 In the Confirm New Password text field, type the new password again, click OK, then click 
Close.

Removing Your Password

1 Click Tools, then click Options.

2 Click Security, then click the Password tab.

3 Type your old password, then click OK.

4 Click Clear Password.

5 Click OK, then click Close.
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3 Working with Items in Your Mailbox

GroupWise® provides many options for sending and receiving different kinds of e-mail.

“Understanding GroupWise Item Types” on page 27

“Sending and Receiving Items” on page 28

“Using Routing Slip” on page 31

“Attaching Files” on page 32

“Managing Sent Items” on page 33

“Managing Received Items” on page 35

Understanding GroupWise Item Types
Every day you communicate in a variety of ways. To accommodate these needs, GroupWise 
delivers your items using a variety of item types. Each item type is explained below.

Mail

A mail message is for basic correspondence, such as a memorandum or letter.

Appointment

An appointment lets you invite people to and schedule resources for meetings or events. You can 
schedule the date, time, and location for the meeting. You can use posted appointments to schedule 
personal events such as a doctor’s appointment, a reminder to make a phone call at a certain time, 
and so forth. Appointments display on the Calendar. See “Scheduling Appointments” on page 43.

Task

A task lets you place a to-do item on your own or on another person’s Calendar. You can schedule 
a due date for the task and include a priority (such as A1). Uncompleted tasks are carried forward 
to the next day. See “Sending Tasks” on page 46.
TIP: You can also create a checklist that is not associated with your Calendar. In this type of checklist, any 
item type (mail, appointment, task, reminder note, phone message) can be used. For information, see 
“Creating a Checklist” on page 39.

Reminder Note

A reminder note is posted on a specific date on your own or another person’s Calendar. You can 
use reminder notes to remind yourself or others of deadlines, holidays, days off, and so forth. 
Posted reminder notes are useful as reminders for things like birthdays, vacations, and pay days. 
See “Sending Reminder Notes” on page 49.
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Phone Message

A phone message helps you inform someone of a phone call or visitor. You can include such 
information as caller, phone number, company, urgency of the call, and so forth. You cannot 
answer your phone from a phone message. See “Sending Phone Messages” on page 29.

Sending and Receiving Items
This section contains the following topics:

“Sending Mail Messages” on page 28

“Sending Phone Messages” on page 29

“Changing the Font of Items You Send” on page 29

“Adding a Signature or vCard to Items You Send” on page 30

Sending Mail Messages
A mail message has a primary recipient, subject line, date, and can be carbon copied and blind 
copied to other users. You can also attach files, document references, sounds, movies, and OLE 
objects to your mail messages.

CC (Carbon Copy)

Carbon copy recipients (CC) receive a copy of an item. CC recipients are users who would benefit 
from the information in an item, but are not affected by or directly responsible for it. All recipients 
can see that a carbon copy was sent. They can also see the names of the CC recipients.

BC (Blind Copy)

Blind copy recipients (BC) receive a copy of an item. Other recipients receive no information 
about blind copies. Only the sender and the blind copy recipient know that a blind copy was sent. 
If a recipient replies and chooses Reply to All, the blind copy recipient does not receive the reply.

1 Click  on the toolbar.

You can select a different mail view by clicking the down arrow in .

2 In the To box, type a username, then press Enter. Repeat for additional users. If necessary, type 
usernames in the CC and BC boxes.

or

To select usernames from a list, click Address on the toolbar, double-click each user, then 
click OK.

3 To change the From name (to another account or proxy), click , then click a name.

4 Type a subject.

5 Type a message.

You can specify many options, such as making this message a high priority, requesting a reply 
from recipients, and more, by clicking the Send Options tab.

If you want, you can change the font of the message text. For information, see “Changing the 
Font of Items You Send” on page 29.

6 Include any attachments by clicking Attach a File on the toolbar.

7 Click Send on the toolbar.
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Sending Phone Messages
A phone message is a note you can send to notify other GroupWise users of calls they received 
while they were out of the office or unavailable. Phone messages are stored in the recipient’s 
Mailbox. You cannot answer your phone from a phone message.

You can change the phone messages you receive into tasks, reminder notes, or other posted item 
views. This way, you can leave a record of the conversation on the date it was held (reminder note) 
or create a to-do item to complete at a later date (task). 

1 Click File, click New, then click Phone Message.

You can place a New Phone Message button on the toolbar.

2 In the To box, type a username, then press Enter. Repeat for additional users. If necessary, type 
usernames in the CC and BC boxes.

or

To select usernames from a list, click Address on the toolbar, double-click each user, then 
click OK.

3 Type the name, company, and phone number of the caller.

4 Select the check boxes that apply to this phone message.

5 Type the message in the Message box.

If you want, change the font of the message text. For information, see “Changing the Font of 
Items You Send” on page 29.

6 To change the From name (to another account or proxy), click , then click a name.

7 Click Send on the toolbar.

Changing the Font of Items You Send
The recipient of an item sees the changes you make in Plain Text view if he or she views the item 
in Plain Text view. The recipient of an item sees the changes you make in HTML view if he or she 
views the item in HTML view. You might want to let the recipient know which view you composed 
the item in.

This section contains the following topics:

“Changing the Font in Plain Text View” on page 29

“Changing the Font in HTML View” on page 30

Changing the Font in Plain Text View

1 In an open item you are composing, click View, then click Plain Text.

2 Click the Message box.

3 Click Edit, click Font, then click Font again.

4 Select a font and a font style.

5 Select a size.

6 Select any other options you want to change, then click OK.

You can also bold, italicize, or underline portions of text using toolbar buttons.
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Changing the Font in HTML View

1 In an open item you are composing, click View, then click HTML.

2 Use the HTML toolbar to change the font, add background colors, add images, and more. 

You might need to re-size the item view horizontally to see all the buttons on the HTML toolbar.

You can set a default font for items you compose in HTML view. For information, see “Viewing 
and Composing Items in HTML” on page 41.

Adding a Signature or vCard to Items You Send
Use Signatures to insert a signature or tag-line at the end of items you send. For example, you can 
have GroupWise automatically list your name, phone number, and e-mail address at the bottom of 
every item you send.

You can also have GroupWise automatically add a vCard*, or virtual business card, to the end of 
messages. GroupWise searches the Address Book for your user information and places it at the end 
of any messages you send.

This section contains the following topics:

“Understanding vCard Files” on page 30

“Adding a Signature or vCard to Items” on page 30

Understanding vCard Files

vCards are electronic business cards formatted according to standards set by the Internet Mail 
Consortium. A vCard file has a .vcf extension, and you can add the file to your outgoing e-mail 
items. Third-party companies create software you can use to create vCards that include text, 
graphics, and sound. When you use GroupWise to generate your vCard, it uses the information 
from the fields in your Address Book listing.

To view a vCard that has been attached to an item, right-click it, then click View Attachment.

Adding a Signature or vCard to Items

1 To specify a general signature for all items, click Tools > Options, then click Send.

or

For Macintosh, click GroupWise > Preferences, then click Send.

2 Click the Signature tab.

3 Click Electronic Business Card (vCard) or Signature.

4 If you selected Signature, type the text you want as a signature in the Signature box.

or

If you selected vCard, either specify a .vcf file or leave the field empty to have the vCard use 
information from your listing in the Address Book.

5 Click a signature option.

6 Click OK.

You can have both a signature and a vCard at the same time. If you choose both the signature is 
used by default.
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Using Routing Slip
Use Routing Slip to send a mail message or task to several users consecutively. You determine the 
order of the route. When a user marks the routed item Completed, it is sent to the next user on the 
route.

If there are attachments to the routed item, each user on the route can view and add comments to 
them. When comments are added to an attachment, all subsequent users on the route will see the 
comments. The final user on the route will see all the comments that were added.

You can track the status of a routed item you have sent by checking the item’s Properties. When 
you send a routed item to an external address, the item is automatically marked Completed 
(because the external recipient cannot mark it) and sent to the next user on the route.

If you want to prevent a proxy from marking routed items Completed, you can require a password 
to complete a routed item.

This section contains the following topics:

“Creating a Routed Item” on page 31

“Completing a Routed Item” on page 31

Creating a Routed Item
1 Open a mail message or task.

2 Click Address, then click Routing Slip.

3 Select usernames from the Address Selector dialog box.

You can also specify personal groups as recipients of a routed item. When you use the Address 
Selector dialog box, the group is expanded into its members so that you can specify the order 
of the users in the route. 

4 Type a subject and message.

5 Click Send on the toolbar.

Completing a Routed Item
1 When you are finished with the assignment or instructions in the routed item, open the item.

2 If you need to view and edit an attachment to the routed item, open the attachment in its 
associated application, make your changes, then save the file. The file is saved to your 
computer’s temporary files directory. Do not change the path, or your changes will not be 
included when the routed item is sent to the next recipient. Close the application.
IMPORTANT: To be able to edit attachments in a routed item, you must have the GroupWise 5.5 
Enhancement Pack or higher installed.

3 In the item, select Actions, click Mark Completed, then click OK.

You can also select the Completed check box in the item header.

4 If the sender has required a password to complete the item, type your GroupWise password, 
then click OK.

The item is sent to the next user on the route.

5 Click Close.
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Attaching Files
Use Attach File to send one or more files to other users. You can attach a file that exists on your 
hard disk, diskette, or network drive. The recipients can open the attached file, save it, view it, or 
print it. If you change the attached file after you have sent it, the recipients do not see the changes.

If you attach a file that is password-protected, the recipient cannot open or view the attachment 
without entering the password.

This section contains the following topics:

“Attaching a File to an Item” on page 32

“Viewing Attached Files” on page 32

“Opening Attached Files” on page 32

Attaching a File to an Item
1 Open a new item.

2 Fill in the To, Subject, and Message boxes.

3 Click File, then click Attach File and select the file or files you want to send.

To remove an attached file, right-click the attachment, then click Delete.

4 Click OK.

5 Click Send on the toolbar.

Moving or deleting a file on a disk or network drive does not affect a file you’ve attached to an 
item and sent.

If you delete an attached file, it is not erased from disk or network drive; it is simply removed from 
the attachment list.

Viewing Attached Files
When you click an attached file, the attachment is displayed in the message pane with a viewer. 
This is usually faster than opening the attachment; however, the attachment might not be formatted 
properly. If the attachment type is not supported, you receive an error.

1 Open the item containing the attachment.

2 Click the attachment. 

or

Right-click the attachment, then click View Attachment or View in New Window.

or

If you cannot see an icon representing the attachment in your view, click File, click 
Attachments, then click View.

Opening Attached Files
When you open an attached file by double-clicking it, GroupWise determines the correct 
application to open the file in. You can accept the suggested application, or you can type the path 
and filename to another application.
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1 Open the item containing the attachment.

2 Double-click the attachment.

or

If you cannot see an icon representing the attachment in your view, click File, click 
Attachments, then click Open.

Managing Sent Items
This section contains the following topics:

“Confirming Delivery of Items You’ve Sent” on page 33

“Displaying Sent Items” on page 33

“Resending Items” on page 34

“Retracting Items You’ve Sent” on page 34

“Checking the Status of an Item” on page 35

“Requesting a Reply for Items You Send” on page 35

Confirming Delivery of Items You’ve Sent
GroupWise provides several ways for you to confirm that your item was delivered.

Tracking an Item You Sent

You can check the status in the Properties window of any item you’ve sent. For information, see 
“Checking the Status of Your Items” on page 34.

Receiving Notification When the Item is Opened or Deleted

You can receive notification when the recipient opens or deletes a message, declines an 
appointment, or completes a task.

Requesting a Reply

You can inform the recipient of an item that you need a reply. GroupWise adds a sentence to the 
item stating that a reply is requested and changes the icon in the recipient’s Mailbox to a double 
arrow. For information, see “Requesting a Reply for Items You Send” on page 35.

Displaying Sent Items
You might want to display items you previously sent. For example, you can read a sent item, resend 
it with or without corrections, and in some cases, retract it (if it has not already been opened by the 
recipient).

1 Click the Sent Items folder  in the Folder List.

All sent items reside in this folder unless they are moved to a folder other than the Mailbox or 
Calendar. If a sent item is moved to another folder, it no longer displays in the Sent Items folder. 
To display sent items that have been moved to other folders, open those folders.
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Resending Items
Use Resend to send an item a second time, perhaps with corrections.

1 Click the Sent Items folder in the Folder List.

2 Right-click the item you want to resend, then click Resend.

3 If the item was an auto-date item, click This Instance or All Instances.

4 Make any changes to the item, if necessary, then click Send on the toolbar.

5 Click Yes to retract the original item.

or

Click No to leave the original item.

You can check the Properties of the original item to see if GroupWise was able to retract it. Right-
click the item in the Mailbox, then click Properties. Mail and phone messages cannot be retracted 
if they have already been opened.

Retracting Items You’ve Sent
Use Delete to retract a sent item from the recipient’s Mailbox. You can retract a mail or phone 
message from those recipients who haven’t yet opened the item. You can retract an appointment, 
reminder note, or task at any time.

1 Click the Sent Items folder in the Folder List.

2 Right-click the item you want to retract, then click Delete.

3 Select the appropriate option.

4 If you have selected to retract this item from other recipients’ mailboxes, you can type a 
comment to the recipients, explaining why the item was retracted.

5 Click OK.

To see which recipients have opened your message, right-click the item, then click Properties.

Checking the Status of Your Items
Properties lets you check the status of any item you’ve sent. For example, you can see when an 
item was delivered and when the recipient opened or deleted the item. If a recipient accepted or 
declined an appointment and included a comment, you’ll see the comment in the Properties 
window. You’ll also see if a recipient marked a task Completed.

Properties also shows information about items you receive. You can see who else received the item 
(except for blind copy recipients), the size and creation date of attached files, and more. 

You can save and print status information for an item.

This section contains the following topics:

“Checking the Status of an Item” on page 35

“Saving the Status Information of an Item” on page 35

“Printing the Status Information of an Item” on page 35
34   GroupWise 6.5 Cross-Platform Client User Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
Checking the Status of an Item

1 Right-click an item in your Mailbox or Calendar, then click Properties.

The icons next to an item can also give you helpful status information. See “Icons Appearing Next 
to Items in Your Mailbox and Calendar” on page 17.

Saving the Status Information of an Item

1 Right-click an item, then click Properties.

2 Click File, then click Save As.

GroupWise gives the item a temporary filename. You can change the filename and default 
folder to save the file.

3 Click Save.

Printing the Status Information of an Item

1 Right-click an item, then click Properties.

2 Right-click in the Properties window, then click Print.

Requesting a Reply for Items You Send
1 To request a reply for one item, open an item view, click the Send Options tab, then click 

General.

or

To request a reply for all items you send, click Tools, click Options, then click Send.

2 Click Reply Requested, then specify when you want to receive the reply.

The recipient sees  next to the message. If you select When Convenient, “Reply Requested: 
When convenient” appears at the top of the message. If you select Within x Days, “Reply 
Requested: By xx/xx/xx” appears at the top of the message.

3 Click OK.

Managing Received Items
GroupWise stores all the mail messages, appointments, and other items you receive in your 
Mailbox.

From your Mailbox, you can read items, reply to items, and forward items you’ve received. You 
can organize items by assigning them to categories or by creating a checklist. You can delegate 
tasks and appointments to other users. You can handle unwanted Internet e-mail with Junk Mail 
Handling. You can even change an item, such as a mail message, to another type of item, such as 
an appointment.

This section contains the following topics:

“Reading Items You Receive” on page 36

“Replying to Items You Receive” on page 38

“Forwarding Items to Other Users” on page 38

“Creating a Checklist” on page 39
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“Delegating Items” on page 40

“Viewing and Composing Items in HTML” on page 41

Reading Items You Receive
You can read items you receive in your Mailbox or Calendar. Your Mailbox displays a list of all of 
the items you have received from other users. Posted appointments, tasks, and reminder notes 
appear in your Calendar, not in your Mailbox.

You can open and read all types of new items in your Mailbox. However, you might want to read 
tasks and reminder notes in your Calendar so you can view new messages while looking at your 
schedule.

Phone and mail messages stay in your Mailbox until you delete them. Appointments, reminder 
notes, and tasks stay in your Mailbox until you accept, decline, or delete them. When you accept 
an appointment, reminder note, or task, it is moved to your Calendar.

All Mailbox items are marked with an icon.The icons change depending on whether or not the item 
has been opened. See “Icons Appearing Next to Items in Your Mailbox and Calendar” on page 17 
for more information. 

In addition, all unopened items in your Mailbox are bolded to help you easily identify which items 
and documents you have not yet read. This is especially useful for collapsed discussion threads 
because it saves you the time of expanding each thread to check if there are newly posted items.

This section contains the following topics:

“Reading Items in Your Mailbox” on page 36

“Reading HTML Items” on page 36

“Reading Items in the QuickViewer” on page 36

“Marking an Item Unread” on page 37

Reading Items in Your Mailbox

1 Double-click the item you want to read.

Reading HTML Items

For information about reading items that were composed in HTML, see “Viewing and Composing 
Items in HTML” on page 41.

Reading Items in the QuickViewer

Use QuickViewer to scan the contents of your items. QuickViewer saves time because you don’t 
need to open each item; you simply click an item or press the Down-arrow to read your items. If 
you click a document reference, the document displays in the QuickViewer. You can display an 
item’s attachment by clicking the attachment in the drop-down list on the QuickViewer toolbar. 
OLE attachments, however, do not display in the QuickViewer.

When you read an item in the QuickViewer, the icon changes to the opened status. For example, 
the closed envelope representing a mail message changes to an opened envelope.

You can specify that some folders show QuickViewer every time you open them, while others 
never show QuickViewer.
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1 Click  on the toolbar.

2 Select whether to turn the QuickViewer on in all folders or just the selected folder, then click 
OK. 

3 Size the QuickViewer by dragging a corner of the window or by dragging the horizontal 
dividing line up or down.

If you size and close the QuickViewer, it is the same size when you open it again. Size it by 
dragging a corner of the window, not by clicking the maximize button.

4 In the Mailbox, click each item that you want to read.

To view an attachment, click the drop-down list on the QuickViewer header, then click the 
attachment. You cannot open OLE attachments in the QuickViewer.

Right-click the QuickViewer window to choose other options.

5 To change how information displays in the header, right-click the header and choose options.

6 To close the QuickViewer, click  on the toolbar.

Marking an Item Unread

If you open an item to read it, and then decide you want to read the item later, you can mark the 
item unread. Marking the item unread changes the item to bold and changes the item’s icon to 
unopened so you know you still need to read the item.

1 In the Main Window, click the item in the Item List.

2 Click Actions, then click Read Later.

Marking an item you have opened unread does not change the status of the item in Properties. For 
example, if you have opened an item, then marked the item unread, the sender of the item still sees 
the item status as Opened in the Properties window.
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Replying to Items You Receive
Use Reply to respond to an item. You can reply to everyone who received the original item or to 
the sender only, without needing to create and address a new message. You can also include a copy 
of the original message in your reply. Your reply will include Re: preceding the original subject 
text. You can modify the subject text if you want.

This section contains the following topics:

“Replying to an Item” on page 38

“Replying to an Item in a Shared Folder” on page 38

Replying to an Item

1 Open the item you want to reply to.

2 Click Reply on the toolbar.

3 Click Reply to Sender.

or

Click Reply to All.

To include the message text in your reply, make sure Include Message Received From Sender 
is selected.

4 Click OK.

5 Type your message, then click Send on the toolbar.

If the original item included BC or CC recipients and you selected to reply to all, your reply is sent 
to the CC recipients but not to the BC recipients.

Replying to an Item in a Shared Folder

1 Open or select an item in the shared folder.

2 Click Reply on the toolbar.

3 Click a reply option.

You can reply to the original discussion topic, rather than to the item you are reading. Or, you 
can reply to any item you are reading, whether it's an original discussion topic or someone 
else's reply. In both cases, these replies are posted in the shared folder and not sent to 
individuals. 

If you reply privately to the individual who wrote the item, your reply is not posted to the 
shared folder.

4 Click OK.

5 Type your reply, then click Post on the toolbar.

Forwarding Items to Other Users
Use Forward to send items you receive and document references to other users. When you forward 
an item, it is sent as an attachment to a mail message. The mail message includes your name and 
any additional comments you have made.

This section contains the following topic:

“Forwarding an Item” on page 39
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Forwarding an Item

1 Open the item you want to forward.

2 Click Actions, then click Forward.

or

Click Actions, then click Forward as Attachment.

3 Add the names of the users to whom you want to forward the item.

4 (Optional) Type a message.

5 Click Send on the toolbar.

If you can’t accept an appointment, task, or reminder note, you can delegate the item instead of 
forwarding it. Delegating places a Delegated status in the item’s Properties window, letting the 
sender know you have transferred responsibility for the item to another person.

Creating a Checklist
Use the Checklist folder to create a task list. You can move any items (mail messages, phone 
messages, reminder notes, tasks, or appointments) to this folder and arrange them in the order you 
want. Each item is marked with a check box so that you can check off items as you complete them. 

You can also make other folders work the way the Checklist folder does.

The Checklist folder is a system folder. It replaces the Task List folder. For a comparison of the 
Checklist folder and the Task List folder, see Checklist Folder under “Folder List” on page 13.
IMPORTANT: If you or your system administrator has set up auto-archiving of items in your Mailbox, checklist 
items are archived based on the original date you received the item, not based on the due date you assign it.

This section contains the following topics:

“Creating a Master Checklist in the Checklist Folder” on page 39

“Creating a New Item in the Checklist Folder” on page 40

“Moving an Item to the Checklist Folder” on page 40

“Marking or Unmarking a Checklist Item Completed” on page 40

Creating a Master Checklist in the Checklist Folder

1 Drag items to the Checklist folder .

In the Checklist folder, the items display with a check box to the left of them. When you 
complete an item in the checklist, you can mark it complete by selecting the check box.

You can move items to the Checklist folder from a shared folder only if you are the owner of 
the shared folder.

2 To arrange the items in the order you want, drag them to the position you want, or click them, 
then click the toolbar buttons , , , and . 

You can also create a checklist area in another folder and drag items to the area. After items are in 
a checklist area of any folder, they will also display in the master Checklist folder, even though 
they are still located in the original folder.
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Creating a New Item in the Checklist Folder

1 Click the Checklist folder.

2 If no items exist in the Checklist folder, click the down-arrow on the  icon, then 
click Posted Message.

Type a subject and message, then click Post on the toolbar.

Moving an Item to the Checklist Folder

1 Drag the item to the Checklist folder.

The item or items are moved from this folder to the Checklist folder, where you can arrange them 
in the order you want, assign due dates, mark them Completed, and so forth.

You can only move items to the Checklist folder from a shared folder if you are the owner of the 
shared folder.

To return an item to its original folder, drag the item from the Checklist folder to the original folder.

Marking or Unmarking a Checklist Item Completed

1 Click the box next to the checklist item.

Delegating Items
Use Delegate to reassign a scheduled item to someone else. The sender can determine who you 
delegated the item to by looking at the item’s Properties.

This section contains the following topics:

“Delegating an Appointment, Task, or Reminder Note from the Main Window” on page 40

“Delegating an Appointment, Task, or Reminder Note from the Calendar View” on page 41

Delegating an Appointment, Task, or Reminder Note from the Main Window

1 In the Main Window, click a task, reminder note, or appointment.

2 Click Actions, then click Delegate.

3 In the To box, type a username, then press Enter.

or

To select a username from a list, click Address on the toolbar, double-click the user, then click 
OK.

4 Type any additional comments to the recipient.

5 Click Send on the toolbar.

6 Click Yes if you want this item to remain in your Calendar.

or

Click No if you want this item deleted from your Calendar.
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Delegating an Appointment, Task, or Reminder Note from the Calendar View

1 In a Calendar view, right-click a task, reminder note, or appointment, then click Delegate.

2 In the To box, type a username, then press Enter.

or

To select a username from a list, click Address on the toolbar, double-click the user, then click 
OK.

3 Type any additional comments to the recipient.

4 Click Send on the toolbar.

5 Click Yes if you want the item to remain in your Calendar.

or

Click No if you want the item deleted from your Calendar.

Viewing and Composing Items in HTML
You can view items in GroupWise that have been composed in HTML from other users or from 
Web-based information services. You can click any links that are included in the item and jump to 
the linked Web sites.

If you have Mozilla or Konqueror installed on the same computer as GroupWise, you can compose 
messages in HTML. An HTML toolbar above the Message box gives you HTML options such as 
text formatting, text color, lists, inserting lines and pictures, inserting a background image, and 
inserting links.

For more information, see “Changing the Font of Items You Send” on page 29.

This section contains the following topics:

“Setting the Default View” on page 41

“Setting the View for One Item” on page 42

“Changing the Default Font in the HTML View” on page 42

Setting the Default View

If you do not like your default read or compose view (whether it is HTML or Plain Text), you can 
change it. 

Changing the Default Read View

1 Click Tools > Options.

2 Click General, then select Plain Text or HTML under Default Read View.

3 Click OK.

Changing the Default Compose View

1 Click Tools > Options.

2 Click General, then select Plain Text or HTML under Default Compose View.

3 Click OK.
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Setting the View for One Item

You can change the view for one item only if that item is composed in HTML.

1 Open an item.

2 Click View, then click Plain Text or HTML text.

Changing the Default Font in the HTML View

You can choose a different font for your outgoing messages.

1 From an HTML view, select the font style and size you want to use as the default for your 
messages.
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4 Scheduling Group and Posted Items

You can schedule appointments, tasks, and reminder notes for yourself and other users. You can 
also reserve a block of time with a posted appointment.

For information about how appointments, tasks, and reminder notes differ from other item types, 
see “Understanding GroupWise Item Types” on page 27.

If you want to find out whether someone accepted a task or is coming to your meeting, you can 
check for an accepted or declined status in the item’s Properties. For more information, see 
“Checking the Status of Your Items” on page 34. 

All scheduled items can be retracted or rescheduled, even if the recipients have already opened and 
accepted them. For more information, see “Retracting Items You’ve Sent” on page 34 and 
“Rescheduling an Appointment” on page 44. 

For more information about managing items after they have been sent or received, see “Managing 
Sent Items” on page 33 and “Managing Received Items” on page 35.

This section contains the following topics:

“Scheduling Appointments” on page 43

“Sending Tasks” on page 46

“Sending Reminder Notes” on page 49

“Accepting or Declining Scheduled Items” on page 50

Scheduling Appointments
Use appointments to schedule blocks of time on a specific date or range of dates.

You can use Busy Search to check for a time when all the users and resources you want for an 
appointment are available.

This section contains the following topics:

“Scheduling an Appointment for Other Users” on page 44

“Rescheduling an Appointment” on page 44

“Rescheduling Recurring Appointments” on page 44

“Canceling an Appointment” on page 45

“Scheduling an Appointment for Yourself” on page 45

“Checking When Everyone Is Available” on page 46
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Scheduling an Appointment for Other Users
1 Click  on the toolbar.

2 In the To box, type a username, then press Enter. Repeat for additional users. In addition, 
include any resource IDs (such as conference rooms) in the To box. If necessary, type 
usernames in the CC and BC boxes.

or

To select usernames or resources from a list, click Address on the toolbar, double-click each 
user, then click OK.

3 To change the From name (to another account or proxy), click , then click a name.

4 Type the place description in the Place box.

5 Specify the start date.

or

Click  to specify a date or auto-date for your appointment.

6 Specify a start time and duration. Duration can be in minutes, hours, or days.

7 Type a subject and message.

If you want, change the font of the message text. For information, see “Changing the Font of 
Items You Send” on page 29.

8 If you want to make sure the people and resources for the appointment are available, you can 
do a busy search by clicking Busy Search on the toolbar. See “Checking When Everyone Is 
Available” on page 46.

You can specify many options, such as making this appointment a high priority, requesting a 
reply from recipients, and more, by clicking the Send Options tab.

9 Click Send on the toolbar.

Rescheduling an Appointment
If you want to make sure the people and resources for the appointment are available, you can do a 
busy search by clicking Busy Search on the toolbar. 

1 Click the Sent Items folder in the Folder List.

2 Click the appointment to reschedule.

3 Click Actions, then click Resend.

4 If the original appointment was an auto-date appointment, click This Instance or All Instances.

5 Make your changes, then click Send on the toolbar.

6 Click Yes to retract the original item.

To reschedule an appointment for a new time on the same day, open your Calendar and drag the 
appointment to the new time.

Rescheduling Recurring Appointments
1 Click the Sent Items folder in the Folder List.

2 Click the appointment you want to select. 
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If you are rescheduling just one appointment in a series of recurring appointments, select the 
appointment on the day you want to reschedule.

3 Click Actions, then click Resend.

4 Click All Instances for all appointments in the recurring appointment.

or

Click This Instance for only one appointment in the series of recurring appointments.

5 Make your changes, then click Send on the toolbar.

6 Click Yes to retract the original item.

To reschedule an appointment for a new time on the same day, open your Calendar and drag the 
appointment to the new time.

Canceling an Appointment
You can cancel an appointment if you scheduled it or if you have the necessary Proxy rights to the 
scheduler’s Mailbox.

1 Click the Sent Items folder in the Folder List.

2 Click the appointment you want to cancel.

3 Click Edit, then click Delete.

4 If the original appointment was an auto-date appointment, click This Instance or All Instances.

5 Click All Mailboxes, then click OK.

Scheduling an Appointment for Yourself
If you are not available for meetings, schedule a posted appointment for those times. When another 
user includes you in an appointment and does a busy search, the user can see you are not available 
at those times, but can still schedule over your appointment.

Posted appointments are placed in your Calendar on the date you specify. They are not placed in 
your Mailbox or in any other user’s Mailbox.

1 On the toolbar, click the arrow on the  button, then click Posted Appointment.

or

In your Calendar, open a view with an Appointments List, click a date, then double-click a 
time in the Appointments List.

2 (Optional) Type a subject and a place.

3 Specify the start date and start time if you haven’t already done so.

4 If necessary, click  to specify a date or auto-date for your appointment.

5 Specify a duration. Duration can be in minutes, hours, or days.

6 (Optional) Type a message.

You can specify many options, such as making this appointment a high priority and more, by 
clicking the Options tab.

7 (Optional) Specify a Show Appointment As type by clicking Actions, clicking Show 
Appointment As, then clicking a type.

8 Click Post on the toolbar.
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Checking When Everyone Is Available
Use Busy Search to find a time when all the people and resources you want to schedule for a 
meeting are available.

This section contains the following topics:

“Performing a Busy Search” on page 46

Performing a Busy Search

1 In an appointment you are creating, specify usernames and resource IDs in the To box.

2 Specify the first possible day for the meeting in the Start Date box.

3 Specify the meeting’s duration.

4 Click Busy Search on the toolbar.

The legend at the bottom of the Busy Search dialog box shows the meaning of the various 
Show Appointment As patterns on the grid. 

If  appears to the left of the username or resource, you can click a scheduled time across 
from the username or resource on the Individual Schedules tab to display more information 
about the appointment in the box below. However, the user or resource owner must give you 
appointment Read rights in their Access List before the  icon appears. See “Adding and 
Removing Proxy Names and Rights in Your Access List” on page 64.

To exclude a username or resource from the search without deleting it, click the Available 
Times tab, then click the check box next to the user or resource to deselect it. Excluding a 
person or resource from the search is useful if a user (like a CC recipient) should be invited to 
a meeting but does not necessarily need to attend. To include a user or resource name that has 
been excluded, click the check box next to the user or resource to select it.

5 To remove a user or resource from the Invite to Meeting list after the search, click the 
Available Times tab, click the username or resource to remove, press Delete, then click Yes. 

This is useful if you want to include several conference rooms in the search to find one that is 
available, then eliminate those you do not want.

6 Complete and send the appointment.

If you want to do a busy search before creating an appointment, click Tools, then click Busy 
Search. Specify information in the Busy Search dialog box, then click OK to perform a busy 
search. When you find a time you want for a meeting, click Request Meeting to transfer the 
information to a new appointment view, then complete the appointment.

You can change the search range for one appointment by scheduling the appointment with 
Tools > Busy Search and changing the number in the Number of Days to Search box.

Sending Tasks
A task is an item to be completed by a specified date and time that displays on the Calendar. When 
you assign a task to a user, the user can accept or decline the task, but until it is declined or 
completed, the task appears on the user’s Tasks List and on the user’s Calendar each day.

After it is accepted, a task appears on the Calendar on its start date. When the due date is past, the 
task displays in red on the Calendar. When you mark a task Completed, it no longer carries over 
to the next day on your Calendar.
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After you finish a task, you can mark it Completed. As the originator of an assigned task, you can 
have GroupWise® send you notification when the task is marked Completed. (You must have 
Notify running to receive notification). A Completed status, including the date and time the task 
was marked Completed, is placed in the Properties window.
TIP: You can also create a checklist that is not associated with your Calendar. In this type of checklist, any 
item type (mail, appointment, task, reminder note, phone message) can be used. For information, see 
“Creating a Checklist” on page 39.

This section contains the following topics:

“Assigning a Task to Other Users” on page 47

“Assigning a Task to Yourself” on page 47

“Marking Tasks Completed” on page 48

Assigning a Task to Other Users
1 Click  on the toolbar.

2 In the To box, type a username, then press Enter. Repeat for additional users. If necessary, type 
usernames in the CC and BC boxes.

or

To select usernames from a list, click Address, double-click each user, then click OK.

3 To change the From name (to another account or proxy), click , then click a name.

4 Type the date you want the task to begin and the date you want the task to be completed. You 
can type the same date in both boxes.

or

Click  to specify dates or auto-dates for your task.

5 Type the subject.

6 Type a priority for the task.

The task priority can consist of a character followed by a number. The following are 
acceptable formats: A1, C2, B3, and so forth. Task priorities are optional.

7 Type a description of the task.

You can specify many options, such as making this task a high priority, requesting a reply from 
recipients, and more, by clicking the Send Options tab.

If you want, change the font of the message text. For information, see “Changing the Font of 
Items You Send” on page 29.

8 Click Send on the toolbar.

Assigning a Task to Yourself
1 Click the arrow on the  icon, then click Posted Task.

or

In your Calendar, open a view with a Tasks List (for example, the Day view), click a date, then 
double-click an empty space in the Tasks List.

2 Type a subject.
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3 Type a priority for the task.

The task priority can consist of a character followed by a number. The following are 
acceptable formats: A1, C1, B3, and so forth. Task priorities are optional.

4 Type the date you want the task to begin and the date you want the task to be completed. You 
can type the same date in both boxes.

or

If necessary, click  to specify dates or auto-dates for your task. 

5 Type a message.

You can specify many options, such as making this task a high priority and more, by clicking 
the Send Options tab.

6 Click Post on the toolbar.

Posted tasks are placed in your Calendar. They are not placed in your Mailbox, or in any other 
user’s Mailbox.
TIP: You can also create a checklist that is not associated with your Calendar. In this type of checklist, any 
item type (mail, appointment, task, reminder note, phone message) can be used. For information, see 
“Creating a Checklist” on page 39.

Marking Tasks Completed
When you finish a task, you can mark it Completed. Tasks you mark Completed are not carried 
over to the next day on your Calendar. Completed tasks are distinguished by a check mark in your 
Calendar. Overdue tasks display in red.

If you mark a task Completed, then realize you left some part of it incomplete, you can unmark it. 
Unmarked tasks display on the current day in your Calendar.

When you mark a task Completed, GroupWise sends notification to the originator of the task if he 
or she selected return notification in Send Options. A Completed status, including the date and 
time the task was marked Completed, is placed in the originator’s Properties window.

This section contains the following topics:

“Marking a Task Completed” on page 48

“Checking the Completion Status of a Task” on page 48

Marking a Task Completed

1 Click Window, then click Calendar.

2 Select the check box next to the task.

To unmark a task that has been marked Completed, deselect the marked check box next to the 
task.

Checking the Completion Status of a Task

1 Click the Sent Items folder in the Folder List.

2 Open the task you want to check.

3 Click the Properties tab.
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Sending Reminder Notes
Reminder notes are like mail messages except they are scheduled for a particular day and appear 
on the Calendar for that date. You can use reminder notes to show vacations, holidays, paydays, 
birthdays, and so forth.

This section contains the following topics:

“Scheduling a Reminder Note for Yourself” on page 49

“Scheduling a Reminder Note for Other Users” on page 49

Scheduling a Reminder Note for Yourself
Posted reminder notes are placed in your Calendar on the date you specify. They are not placed in 
your Mailbox or in any other user’s Mailbox.

1 From your Calendar, open a view with a Reminder Notes List (for example, the Week view).

2 Click a date, then double-click an empty space in the Reminder Notes List.

3 If necessary, click  to specify a start date or auto-date for your reminder note.

4 Type a subject and the reminder note.

You can specify many options, such as making this reminder note a high priority and more, 
by clicking the Send Options tab.

5 Click Post on the toolbar.

To access the information later, open your Calendar and select the date the information appears on. 
Double-click the reminder note in the Reminder Notes List.

Scheduling a Reminder Note for Other Users
1 Click File, click New, then click Reminder Note.

2 In the To box, type a username, then press Enter. Repeat for additional users. If necessary, type 
usernames in the CC and BC boxes.

or

To select usernames from a list, click Address on the toolbar, double-click each user, then 
click OK.

3 To change the From name (to another account or proxy), click , then click a name.

4 Type a subject (optional) and the reminder note message.

If you want, change the font of the message text. For information, see “Changing the Font of 
Items You Send” on page 29.

5 In the Start Date box, type the date this reminder note should appear in the recipients’ 
Calendars.

or

Click  to specify a start date or auto-date for your reminder note.

You can specify many options, such as making this reminder note a high priority, requesting 
a reply from recipients, and more, by clicking the Send Options tab.

6 Click Send on the toolbar.
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Accepting or Declining Scheduled Items
When you receive an appointment, task, or reminder note, you might not be able to accept. In 
GroupWise, you can let the sender know if you accept or decline, specify a level of acceptance or 
availability, and add additional comments. You can also delegate the item to another user. The 
sender can find your response by checking the item’s Properties.

1 Open the appointment, task, or reminder note.

2 Click Accept or Decline on the toolbar.

or

Click the down-arrow to the right of the button to select an Accept level of availability, or to 
select Decline with Options.

3 If you selected Decline with Options, you can type a comment (optional), then click OK.

By default, the sender can view your comment by viewing the item properties in the Sent 
Items folder. However, for more noticeable notification when someone declines an item, the 
sender has the option under Tools > Options > Send > Appointment/Task/Reminder Note to 
set Return Notification When Declined to Mail Receipt, Notify, or both.

4 If the item is an Auto-Date item, click This Instance to accept or decline this one Auto-Date 
item, or click All Instances to accept or decline all instances of the Auto-Date item.

Accepting and Declining Resource Requests
You can accept or decline resource requests only if you are the resource owner and have been 
granted Read and Write rights.

1 In the Main Window or Calendar, click File, then click Proxy.

or

Click the folder list header drop-down list (above the Folder List; it probably displays Online 
or Caching to indicate what mode of GroupWise you are running in).

2 Click the resource you own.

If the resource you own isn’t listed, click Proxy, type the name of the resource you own in the 
Name box, then click OK.

3 Double-click the item you need to accept or decline.

4 Click Accept or Decline on the toolbar.
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5 Using Your Calendar

You can view your schedule in a variety of views or formats, including day, week, month, year, 
task list, and project planner. For example, the month view lets you view a month schedule.

You can use Graphic Display to show appointment duration in blocks to visualize time use in your 
schedule. Time intervals in the Appointments List can be adjusted from ten minutes to two hours, 
depending on how detailed a list you want to see. And by using Show Appointment As, you can 
display levels of availability for appointments in Busy Search and in your Calendar.

If you have automatic archiving set, items that have been archived are no longer displayed on your 
calendar. To make them appear on your calendar, unarchive the item from your archive calendar. 
For more information on how to unarchive an item, see “Unarchiving Items” on page 62.

Many types of calendar views and printouts are available to let you choose the one that displays 
the information you need. 

This section contains the following topics:

“Viewing Your Calendar” on page 51

“Reading an Item in Your Calendar” on page 52

“Saving an Item in Your Calendar” on page 52

“Printing Calendar Items” on page 52

“Viewing a Different Date in the Calendar” on page 53

For additional calendaring and scheduling information, see Chapter 4, “Scheduling Group and 
Posted Items,” on page 43.

Viewing Your Calendar
This section contains the following topics:

“Opening the Calendar Folder or a Calendar View” on page 51

“Understanding the Icons Appearing Next to Items in Your Calendar” on page 52

Opening the Calendar Folder or a Calendar View
The calendar view in the folder list has a toolbar that provides access to several Calendar view 
options. You can add more buttons to the Calendar toolbar and configure them however you want. 
The view that is displayed when you exit your Calendar will be displayed when you open the 
Calendar folder again. 

1 Click Calendar in the Folder List, then click the buttons on the Calendar toolbar to choose 
different views.
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or

Click Window, click New Calendar Window, then click a calendar view.

You can view the Calendar in various formats, including week, month, and year. Click a different 
button on the Calendar toolbar.

If you want, you can close your folder list to leave more room for other views in the Main Window. 
Click  to close the Folder List display and  to open the Folder List display. 

Understanding the Icons Appearing Next to Items in Your Calendar
The icons that appear in your calendar give you additional information about items. See “Icons 
Appearing Next to Items in Your Mailbox and Calendar” on page 17 for more information.

Reading an Item in Your Calendar
1 Click Calendar in the Folder List.

2 Double-click the item you want to read.

Saving an Item in Your Calendar 
1 In your Mailbox or Calendar, click the item you want to save, click File, then click Save As.

2 Ctrl+click the item and attachments you want to save.

3 Select to save the item to disk.

4 Type a filename for the item in the Save File As box.

5 To save the item in a different directory than is shown in the Current Directory text box, click 
Browse, then select the new directory.

6 Click Save, then click Close.

Printing Calendar Items
Use Print Calendar to print appointments, tasks, and reminder notes in different formats and on 
various page sizes.

This section contains the following topics:

“Printing Your Calendar, Task List, or Reminder Note List” on page 52

Printing Your Calendar, Task List, or Reminder Note List
1 Click File, then click Print Calendar.

2 Click a calendar format in the Select Item to Be Printed box.

3 Click a calendar view under Select Available Print Forms.

4 Click the Content tab, type a starting date, then read and select other options.

5 Click the Preview button to see how the page layout looks with the selected options. If 
necessary, change the options.

6 Click Print.
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Viewing a Different Date in the Calendar
1 If the view displayed has a Calendar toolbar, click , then click a date.

2 Click  to return to today’s date.

Going to a different date is not applicable to some views.
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6 Managing Your Mailbox

GroupWise® provides many features to help you manage your Mailbox.

This section contains the following topics:

“Using the Folder List” on page 55

“Using Shared Folders” on page 57

“Managing Contacts Through Your Mailbox” on page 58

“Archiving the Items in Your Mailbox” on page 61

“Printing Items in Your Mailbox” on page 62

“Giving Other People Access to Your Mailbox” on page 63

“Saving Items in Your Mailbox” on page 65

“Owning Resources” on page 65

“Opening and Emptying the Trash” on page 66

“Deleting Items from Your Mailbox” on page 67

“Backing Up Your Mailbox” on page 68

“Finding Items” on page 68

“Filtering Items” on page 68

“Using the Columns in Your Mailbox” on page 69

Using the Folder List
Use folders to store and organize your items. For example, you can group all items related to a 
particular task or subject together.

All folders in your Main Window are subfolders of your user folder. The user folder represents 
your user database, and contains all of your GroupWise information. 

For information about the individual folders you might have in your Folder List, see the following:

“User Folder” on page 13

“Mailbox Folder” on page 13

“Sent Items Folder” on page 14

“Calendar Folder” on page 14

“Contacts Folder” on page 14

“Checklist Folder” on page 14
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“Documents Folder” on page 15

“Trash Folder” on page 15

“Shared Folders” on page 15

Click + and - to expand and collapse folders.

Next to any folder (except for shared folders), the number of unread items is shown in square 
brackets. Next to the Sent Items folder, the number in square brackets shows how many items are 
pending to be sent from Caching mode.

You can organize items in your folders by moving them. When you move an item into a folder, it 
is taken from one location and placed in another. 

You can define a different set of properties for each folder in your Mailbox. For example, you can 
sort the items in one folder by date, and sort the items in another folder by company.

If you use GroupWise for Windows on another computer, the Linux or Mac client will mirror your 
Windows client’s sort settings. However, from that point forward, the sort settings in the two 
clients will be independent of each other.

You can store all of your documents in the Documents folder. You can also make folders public by 
sharing them. (See “Using Shared Folders” on page 57.)

This section contains the following topics:

“Renaming Folders” on page 56

“Deleting Folders” on page 56

“Creating a Personal Folder” on page 56

“Creating a Shared Folder” on page 57

Renaming Folders
1 In the Main Window, right-click the folder, then click Rename.

2 Type a new name for the folder.

You cannot rename the Calendar, Documents, Mailbox, Sent Items, Checklist, Contacts, Cabinet, 
Work In Progress, or Trash folders.

Deleting Folders
1 Right-click the folder you want to delete, then click Delete.

2 Click Items Only or Folder(s) and Items, then click OK.

You cannot delete the Calendar, Documents, Mailbox, Sent Items, Checklist, Contacts, Cabinet, 
Work In Progress, or Trash folders.

To delete a folder that is shared with you, right-click the folder, click Delete, then click Yes.

Creating a Personal Folder
1 In the Folder List, click File, click New, then click New Folder.

2 Make sure Personal Folder is selected, then click Next.
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3 Type the name and description for the new folder.

4 Specify the display settings for the folder, then click Finish.

If you create a folder, then decide you want it in a different position, drag the folder to a new 
position in the Folder List.

Creating a Shared Folder
1 In the Folder List, click File, click New, then click New Folder.

2 Click Shared Folder, then click Next.

3 Type a name and description for the new folder.

4 In the Name box, start typing the name of the user.

5 When the user’s name appears in the box, click Add User to move the user into the Share List.

6 Click the user’s name in the Share List.

7 Select the access options you want for the user.

8 Repeat Steps 6-9 for each user you want to share the folder with.

9 When you’re done, click OK.

For more information about shared folders, see “Using Shared Folders” on page 57.

Using Shared Folders
A shared folder is like any other folder in your Cabinet, except other people have access to it and 
it appears in their Cabinets. You can create shared folders or share existing personal folders in your 
Cabinet. You choose whom to share the folder with, and what rights to grant each user. Then, users 
can post messages to the shared folder, drag existing items into the folder, and create discussion 
threads. You can’t share system folders, which include the Calendar, Documents, Mailbox, Sent 
Items, Checklist, Contacts, Cabinet, Work In Progress, and Trash folders.

If you place a document in a shared folder, people with rights to the shared folder have rights to 
view the document only.

In Caching mode, changes in shared folders are updated whenever you connect to the master 
GroupWise system.

This section contains the following topics:

“Sharing an Existing Folder with Other Users” on page 57

“Posting a Message to a Shared Folder” on page 58

Sharing an Existing Folder with Other Users
1 In the Main Window, right-click the folder you want to share, then click Sharing.

2 Click Shared With.

3 In the Name box, start typing the name of a user, or click the Address Book button to select 
the user from the Address Selector dialog box.

4 When the user’s name appears in the box, click Add User to move the user into the Share List.

5 Click the user’s name in the Share List.
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6 Select the access options you want for the user.

7 Repeat Steps 3-6 for each user you want to share the folder with.

8 Click OK.

Posting a Message to a Shared Folder
1 Click the shared folder in your Folder List to open it.

2 Click File, click New, then click Discussion/Note.

If you want to post a different type of item, such as a task, click Edit, click Change To, then 
click an item type.

3 Type a subject.

4 Type your message.

5 Click Attach to attach files.

6 Click Post on the toolbar.

To reply to an existing item in a shared folder, open the item, click Reply, select a reply option, 
then click OK. See “Replying to an Item in a Shared Folder” on page 38 for more information.

Managing Contacts Through Your Mailbox
GroupWise Contact Management gives you access to your contacts, groups, resources, and 
organizations from the  Contacts folder in the Folder List.

The Contacts folder shows, by default, all the entries in your Frequent Contacts address book. 

Any modification you make in the Contacts folder is also made in the corresponding address book 
(Frequent Contacts or other address book). Any modification you make in the address book are 
reflected in the Contacts folder. For more information about address books, see Chapter 7, “Using 
the Address Book,” on page 71.

Your proxies never see your Contacts folder.

Use the Contacts folder to view, update, delete, and add information for contacts, groups, 
resources, and organizations in the selected address book.

To see contacts, groups, resources, and organizations from another address book, change the 
address book that the Contacts folder displays.

This section contains the following topics:

“Managing Contacts” on page 59

“Managing Groups” on page 60

“Managing Resources” on page 60

“Managing Organizations” on page 60

“Changing the Display Name of a Contact” on page 61
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Managing Contacts
Each contact in the Contacts folder is marked with the  Contact icon. When you double-click a 
contact, the contact item view displays. 

The following table explains the purpose of each tab on the contact item view. 

Tab Purpose

Contact Use this tab to enter the contact’s name, multiple e-mail addresses, multiple 
phone numbers, and multiple instant messaging IDs.

Click the Display drop-down list to select how you want the name to display in 
Name Completion. You can select Last, First, First Last, or you can specify any 
display name you choose. When you want to address an item to this contact, type 
the display name in an address field (To, CC, BC) of the item.

If you double-click an e-mail address on the Contact tab, a new mail view is 
opened, addressed to this contact.

If you double-click an instant messaging ID from a supported product, the instant 
messaging product is opened (if installed) and a conversation is initiated with this 
contact.

You can specify multiple phone numbers. Select the option button of the default 
phone number.

Office Use this tab to enter the contact’s title, department, organization, company 
address, mail stop, and company Web site.

Type an organization name. If it is already in your address book, Name 
Completion fills in the name. If the organization name is not already in your 
address book, the name you enter will be added to your address book. Use the 
arrow button to add more information to the organization.

Click the Web site button to launch a browser and go to the Web site.

Personal Use this tab to enter the contact’s home address, personal Web site, and birthday.

Click the Web site button to launch a browser and go to the Web site.

Click the calendar button to select the birthday of this contact. When the check 
box next to the date is selected, the birthday information is displayed on the 
Summary tab and in the Birthday column if you have added one to an address 
book. Selecting the check box does not add the birthday to your Calendar. If you 
deselect the check box, the birthday information is available only on the Personal 
tab.

Comments Use this tab to type information about your interaction with this contact. You can 
insert a time stamp for each entry.
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Managing Groups
Each group in the Contacts folder is marked with the  Group icon. When you double-click a 
group, the group item view displays. 

The following table explains the purpose of each tab on the group item view. For specific help 
about each field on a tab, click a field in the group item view, then press Shift+F1.

Managing Resources
Each resource in the Contacts folder is marked with the  Resource icon. When you double-click 
a resource, the resource item view displays. 

The following table explains the purpose of each tab on the resource item view. For specific help 
about each field on a tab, click a field in the resource item view, then press Shift+F1.

Managing Organizations
Each organization in the Contacts folder is marked with the  Organization icon. When you 
double-click an organization, the organization item view displays. 

The following table explains the purpose of each tab on the organization item view. For specific 
help about each field on a tab, click a field in the organization item view, then press Shift+F1.

Tab Purpose

Details Use this tab to specify a name for the group, a description of the group, and see 
who is included in the group. You can also select a member of the group and 
press Delete to remove the name. If you right-click a name, you can see details, 
remove the name, or change the designation of To, CC and BC.

Use the Members button to add entries to the group. For more information, see 
“Adding and Removing Contacts from a Personal Group” on page 77.

Tab Purpose

Details Use this tab to specify a name for the resource, a phone number, resource type, 
e-mail address, owner, and comments about this resource.

In the Owner field, you can specify a contact that is already in your address book, 
or you can use the arrow button to create a new contact entry.

Tab Purpose

Details Use this tab to specify a name for the organization, a phone and fax number, the 
primary contact in this organization, the address, Web site, and comments about 
this organization. 

In the Primary Contact field, you can specify a contact that is already in your 
address book, or you can use the arrow button to create a new contact entry.

People This shows the members of this organization. These are the contacts who have 
this organization specified on the Office tab.
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Changing the Display Name of a Contact
The display name is the name that displays when you begin typing in the To (or BC or CC) field 
of a message. When you begin typing a name, for example, “Ta,” Name Completion fills in the 
rest of the name with a name from the address book, for example “Tabitha Hu.” However, if there 
are two Tabitha Hus in the address book, one in Accounting and one in Facilities, it might be 
difficult for you to know which name Name Completion has filled in, unless you take the time to 
look at more properties.

You can change the display name so that it’s easy to know which name Name Completion has filled 
in. For example, if you only correspond with Tabitha Hu in Accounting, you could change the 
display name to Tabitha--Accounting.

1 Click the Contacts folder.

2 Double-click a contact.

3 Click the Contact tab.

4 Click the Display field.

5 Type a new display name.

6 Click OK.

The next time you address a message, Name Completion fills in this Display Name.

Archiving the Items in Your Mailbox
Use Archive to save mail or phone messages, appointments, reminder notes, or tasks to a 
designated database on a local drive. Archiving items saves network space and keeps your 
Mailbox uncluttered. It also protects items from being automatically deleted. 

You can view archived items whenever you need to. You can also unarchive any archived item. 
When you archive an item you have sent, you cannot track the status of that item.

The system administrator might specify that your items are archived automatically on a regular 
basis.

When you move an item to a folder, it is not archived. Items in all folders are affected by the 
cleanup options your administrator specifies.

This section contains the following topics:

“Archiving an Item in Your Mailbox” on page 61

“Viewing Archived Items” on page 62

“Unarchiving Items” on page 62

Archiving an Item in Your Mailbox
1 If you have not previously done so, specify the archive path in the Options dialog box. See 

“Specifying Where Archived Items Are Stored” on page 88.

2 Select the items in your Mailbox you want to archive.

3 Click Actions, then click Move to Archive.

When you archive an item you have sent, you cannot track the status of that item.
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Viewing Archived Items
1 In the Main Window, click File, then click Open Archive.

or

Click the folder list header drop-down list (above the Folder List; it probably displays Online 
or Caching to indicate what mode of GroupWise you are running in), then click Archive.

Unarchiving Items
1 Click File, then click Open Archive.

or

Click the folder list header drop-down list (above the Folder List; it probably displays Online 
or Caching to indicate what mode of GroupWise you are running in), then click Archive.

2 Click the item you want to unarchive, click Actions, then click Move to Archive.

3 Click File, then click Open Archive to close the archive and return to the Main Window.

or

Click the folder list header drop-down list (above the Folder List; it displays Archive), then 
click your user folder (your name) to return to the mode of GroupWise you were running 
previously.

Unarchived messages are returned to the folder from which they were archived. If the folder has 
been deleted, GroupWise creates a new folder.

If your system administrator has specified that items are automatically archived on a regular basis, 
you might not be able to change this option.

If you or your system administrator has set up auto-archiving of items in your Mailbox, items in 
the Checklist folder are also archived based on the original date you received the item, not based 
on the due date you assign it.

If you have automatic archiving setup, it only archives items to one computer. If you are working 
on a computer where the automatic archive is not available, the items are not archived to the 
computer where the archive is not available.

Printing Items in Your Mailbox
This section contains the following topics:

“Printing GroupWise Items” on page 62

“Printing Calendars” on page 63

Printing GroupWise Items
1 In the Item List in your Mailbox, click or open the item you want to print.

2 Click File, then click Print.

3 Select the items and attachments you want to print.

Select Print Attachment with Associated Application to launch the application in which an 
attached file was created (if that application is available). This might increase printing time 
but ensures correct formatting of the file. Printing from GroupWise might save time, but the 
formatting of the attached file might change.

4 Click Print.
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If you launch an associated application, you need to select to print the file after the application 
is open. When printing is complete, close the application.

Printing Calendars
Use Print Calendar to print your schedule including appointments, tasks, and reminder notes in 
different formats and on various page sizes. For example, you could print a day calendar with all 
your appointments or a week calendar with all your appointments and tasks. 

For information about printing your GroupWise calendar, see “Printing Calendar Items” on 
page 52.

Giving Other People Access to Your Mailbox
Use Proxy to manage another user’s Mailbox and Calendar. Proxy lets you perform various 
actions, such as reading, accepting, and declining items on behalf of another user, within the 
restrictions the other user sets.
IMPORTANT: You can proxy for a user in a different post office or domain, as long as that person is in the 
same GroupWise system. You cannot proxy for a user in a different GroupWise system.

This section contains the following topics:

“Receiving Proxy Rights” on page 63

“Assigning Proxy Rights to Another User” on page 63

“Adding and Removing Proxy Names and Rights in Your Access List” on page 64

“Managing Someone Else's Mailbox or Calendar” on page 64

“Adding and Removing Users in Your Proxy List” on page 65

Receiving Proxy Rights
Two steps must be completed before you can act as someone’s proxy. First, the person for whom 
you plan to act as proxy must grant you rights in the Access List in Options. Second, you must add 
that user’s name to your Proxy List so you can access his or her Mailbox or Calendar.

When these two steps are complete, you can open your Proxy List and click the name of the person 
you’re proxying for whenever you need to manage his or her Mailbox or Calendar.

Assigning Proxy Rights to Another User
Use the Access List in Security Options to give other users rights to proxy for you. You can assign 
each user different rights to your calendaring and messaging information. If you want to let users 
view specific information about your appointments when they do a Busy Search on your Calendar, 
give them Read access for appointments. The following table describes the rights you can grant to 
users:

This right Lets your proxy do this

Read Read items you receive. Proxies cannot see your Contacts folder with this or 
any other proxy right.
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Adding and Removing Proxy Names and Rights in Your Access List
1 Click Tools, then click Options.

2 Click Security, then click the Proxy Access tab.

3 To add a user to the list, type the name in the Name box, then when the full name appears, 
click Add User.

4 Click a user in the Access List.

5 Select the rights you want to give to the user.

6 Repeat Steps 4-5 to assign rights to each user in the Access List.

You can select All User Access in the Access List and assign rights to all users in the Address 
Book. For example, if you want all users to have rights to read your mail, you would assign 
Read rights to All User Access.

7 To delete a user from the Access List, click the user, then click Remove User.

8 Click OK.

Managing Someone Else's Mailbox or Calendar
Before you can act as a proxy for someone, that person must give you proxy rights in his or her 
Access List in Options. The amount of access you have depends on the rights you have been given. 

1 If you haven’t already done so, add the username of the person to your Proxy List.

See “Adding and Removing Users in Your Proxy List” on page 65.

2 In the Main Window, click the folder header drop-down list, then click Proxy.

3 Click the name of the person whose Mailbox you want to access.

4 When you have finished your work in the other person’s Mailbox, click the folder list header 
drop-down list, then click your own name to return to your Mailbox.

You can work with several Mailboxes open at one time by opening a new Main Window for each 
Mailbox (click Window, click New Main Window, then switch to the Mailbox you want.) You can 
tell the Mailboxes apart by looking for the Mailbox owner’s name, which appears as the root folder 
label for each Mailbox.

Write Create and send items in your name, including applying your signature (if you 
have one defined). Assign categories to items, change the subject of items, 
and perform checklist options on items.

Subscribe to my 
alarms

Receive the same alarms you receive. Receiving alarms is supported only if 
the proxy is on the same post office you are.

Subscribe to my 
notifications

Receive notification when you receive items. Receiving notifications is 
supported only if the proxy is on the same post office you are.

Modify options/
folders

Change the options in your Mailbox. The proxy can edit any of your Options 
settings, including the access given to other users. If the proxy also has Mail 
rights, he or she can create or modify folders. This right allows a proxy to add, 
delete, and modify categories.

Read items marked 
Private

Read the items you marked Private. If you don’t give a proxy Private rights, 
all items marked Private in your Mailbox are hidden from that proxy.

This right Lets your proxy do this
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Adding and Removing Users in Your Proxy List
Before you can act as a proxy for someone, that person must give you proxy rights in his or her 
Access List in Options, and you must add that person’s name to your Proxy List. The amount of 
access you have depends on the rights you have been given. 

1 In the Main Window, click the folder header drop-down list, then click Proxy.

or

Click the folder list header drop-down list (above the Folder List; it probably displays Online 
or Caching to indicate what mode of GroupWise you are running in), then click Proxy.

2 To remove a user, click the name, then click Remove.

3 To add a user, type the name in the Name field, then click OK.

The user’s Mailbox is opened. The name of the person for whom you are acting as proxy is 
displayed at the top of the Folder List.

If the user has not yet given you proxy rights in his or her Access List, the name is added to 
the Proxy List but the user’s Mailbox is not opened.

4 To return to your own Mailbox, click the folder list header drop-down list, then click your 
name.

You can work with several Mailboxes open at one time by opening a new Main Window for each 
Mailbox (click Window, click New Main Window, then switch to the Mailbox you want.) You can 
tell the Mailboxes apart by looking for the Mailbox owner’s name, which appears as the root folder 
label for each Mailbox.

Removing a user from your Proxy List does not remove your rights to act as proxy for that user. 
The user whose Mailbox you access must change your rights in his or her Access List.

Saving Items in Your Mailbox
This section contains the following topics:

“Saving an Item in Your Mailbox” on page 65

Saving an Item in Your Mailbox
1 Select an item.

2 Click File, then click Save As.

GroupWise gives the item a default filename of the subject with no spaces. You can change 
the filename and default folder to save the file.

3 Click Save.

Owning Resources
Resources are items that can be scheduled for meetings or other uses. Resources can include 
rooms, overhead projectors, cars, and more. The system administrator defines a resource by giving 
it an identifying name and assigning it to a user. Resources can be included in a busy search, just 
as users can. Resource IDs are entered in the To box. A user assigned to manage a resource is the 
owner of that resource.
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The owner of a resource is responsible to accept and decline appointments for the resource. In 
order to do so, the owner must have full proxy rights to the resource. As a resource owner, you can 
select to receive notification of appointments for the resource. 

This section contains the following item:

“Accepting and Declining Resource Requests” on page 66

Accepting and Declining Resource Requests
You can accept or decline requests for a resource only if you are the owner and have been granted 
Read and Write access.

1 In the Main Window or Calendar, click File, then click Proxy.

or

Click the folder list header drop-down list (above the Folder List; probably displays Online or 
Caching to indicate what mode of GroupWise you are running in).

2 Click the resource you own.

If the resource you own isn’t listed in the Proxy pop-up list, click Proxy, type the name of the 
resource you own in the Name box, then click OK.

3 Double-click the item you need to accept or decline.

4 Click Accept or Decline on the toolbar.

Opening and Emptying the Trash
All deleted mail and phone messages, appointments, tasks, documents, and reminder notes are 
stored in the Trash. Items in the Trash can be viewed, opened, or returned to your Mailbox until 
the Trash is emptied. (Emptying the Trash removes items in the Trash from the system.) 

You can empty your entire Trash, or empty only selected items. You can empty the Trash manually. 
The system administrator can specify that your Trash is emptied automatically on a regular basis.

This section contains the following topics:

“Opening Your Trash” on page 66

“Undeleting an Item in the Trash” on page 67

“Saving an Item That Is in Your Trash” on page 67

“Emptying the Trash” on page 67

“Emptying Selected Items from the Trash” on page 67

Opening Your Trash
1 In your Folder List, click .

You can open and save items in the Trash. You can also permanently remove items, return them to 
the Mailbox, or view information for items. Right-click an item in the Trash to see more options.
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Undeleting an Item in the Trash
1 In your Folder List, click .

2 Select the items you want to undelete.

3 Click Edit, then click Undelete.

The undeleted item is placed in the folder from which it was originally deleted. If the original 
folder no longer exists, the item is placed in your Mailbox.

You can also restore an item by dragging it from the Trash folder to any other folder.

Saving an Item That Is in Your Trash
You can save items that are in the Trash the same way you would save any other item. 

Emptying the Trash
1 Right-click , then click Empty Trash.

Emptying Selected Items from the Trash
1 In your Folder List, click .

2 Select one or more items.

3 Click Edit, click Delete, then click Yes.

Deleting Items from Your Mailbox
Use Delete to remove selected items from your Mailbox. You can also use Delete to retract items 
you have sent. You can retract mail and phone messages if the recipients have not read them or if 
they have not been sent to the Internet. You can retract appointments, reminder notes, and tasks at 
any time.

This section contains the following topics:

“Deleting an Item from Your Mailbox” on page 67

“Deleting and Emptying Items from Your Mailbox” on page 67

Deleting an Item from Your Mailbox
1 In the Main Window, select one or more items, then press the Delete key.

2 If you delete a sent item, the Delete Item dialog box displays. Select the appropriate Delete 
From option, then click OK.

If you delete a document reference from your Mailbox, only the reference is deleted. The 
document remains in the library.

Deleted items are moved to your Trash and remain there until the Trash is emptied. 

Deleting and Emptying Items from Your Mailbox
1 In the Main Window, select one or more items, click Edit, then click Delete and Empty.

Deleted items are not moved to your Trash if you select this option; they are unrecoverable.
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Backing Up Your Mailbox
Your system administrator typically backs up your network mailbox on a regular basis. You can 
back up your local mailbox if you want to have an additional copy of your mailbox, or if you want 
to back up information that is no longer in your network mailbox. 

You should periodically back up your Mailbox Caching Directory to a different location. If the 
Caching Mailbox should become corrupted, you can either make a new Caching mailbox based on 
your current Online mailbox or restore your backup into your Caching mailbox directory.

Finding Items
Use Find to look for items that match the criteria you specify.

This section contains the following topic:

“Finding an Item Using Search Criteria” on page 68

Finding an Item Using Search Criteria
This section contains the following topics:

“Finding an Item Using Search Criteria” on page 68

“Narrowing a Find” on page 68

Finding an Item Using Search Criteria

1 Click  on the toolbar.

2 To search for specific text, type what you are looking for in the Full Text or Subject text boxes.

3 To search for a name, type the name in the From or To/CC text box.

4 Click Search to begin the Find.

Narrowing a Find

In the Subject and Message text boxes of the Find dialog box, type the uncommon words you 
have noticed in the item. If you search using common words, the results of your search are 
likely to find too many items to be very helpful.

If you cannot find the document or message, check your search criteria for misspelled words. 
In addition, check the syntax of your search to make sure you are telling Find to search for 
exactly what you want.

Filtering Items
If your Mailbox or Calendar contains many items, you might have a difficult time finding just one 
of them. Filter  lets you display items according to specific criteria: received items, sent items, 
and/or posted items. Filter does not actually move or delete items; it displays certain items based 
on the criteria you specify.
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Using the Columns in Your Mailbox
The Item List in the Main Window is divided into columns. Each column displays information 
about the items in the list. For example, different columns display the subject of items, the date 
they were sent, and so forth. You can sort the items in your mailbox by column.

1 Click the folder containing the items you want to sort.

2 Click a column heading. To reverse the sort order, click the column heading a second time.
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7 Using the Address Book

Use an address book like a contact management tool, phone directory, and information center for 
your addressing needs. Address books can store names and addresses, e-mail addresses, phone 
numbers, and much more. 

Entries in an address book can be a contact, group, resource, or organization. For information 
about the information you can store in each type of entry, see “Managing Contacts” on page 59, 
“Managing Groups” on page 60, “Managing Resources” on page 60 and “Managing 
Organizations” on page 60.

This section contains the following topics:

“Understanding Address Books” on page 71

“Searching for Users and Resources” on page 74

“Using Groups to Address Items” on page 75

“Printing Lists from the Address Book” on page 77

“Using the Address Selector and Address Book to Send Messages” on page 78

“Using Frequent Contacts” on page 79

“Creating Personal Address Books” on page 80

“Sharing an Address Book with Another User” on page 81

Understanding Address Books
Click a link below to learn about different types of address books.

“Using the Address Book, the Address Selector, and the Contacts Folder” on page 71

“System Address Book” on page 73

“Frequent Contacts Address Book” on page 74

“Personal Address Books” on page 74

“Shared Address Books” on page 74

Using the Address Book, the Address Selector, and the Contacts Folder
There are three ways to access address book information: the Address Book, the Address Selector, 
and the Contacts Folder.
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Address Book

To open the GroupWise® Address Book, click the Address Book button  on the 
Main Window toolbar. The Address Book opens, displaying a left pane that lists the system 
address book, Frequent Contacts address book, and any personal address books you have created. 

You can use File > Open Book and File > Close Book to display and hide the address books in this 
pane. The right pane lists all the entries in the selected address book.

What You Can Do in the Address Book

Using the Address Book, you can open contacts to view details, select names to send an item to, 
create and modify groups, and create and delete contacts.

The Address Book also provides you with advanced address book options, such as creating and 
modifying personal address books, changing your Name Completion search order, changing the 
properties of an address book, defining copy options, changing your MAPI configuration, 
importing and exporting address books, sharing address books, adding directory services, printing 
labels, and more.

Address Selector

When you are composing a new item and click the Address button  on the item view 
toolbar, the Address Selector displays. The Address Selector presents a simplified view of the 
Address Book, providing you with the options you need to select a name or create a group. 

Changing the Address Book Displayed in the Address Selector

In the Address Selector, you view one address book at a time. To choose a different address book 
to look at, click an address book in the Look In drop-down list.

What You Can Do in the Address Selector

Double-click the entries you want placed in To, CC, or BC fields of the item you are addressing. 
You can filter the list of entries by contacts, groups, and resources using the  drop-down list. 
You can search the list by name, first name, or last name using the Match drop-down list. 
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You can change the column order in the list of address entries. You can change the sort order of 
the list based on the entries in any column. You can resize the Address Selector by dragging a 
corner of the window. You can open a contact entry to view details by clicking the contact, then 
clicking Details. 

You can add contacts to the right pane and then create a group by clicking Save Group. If you click 
the down-arrow on the Send Group button, you can select which address book the group is saved 
to. Otherwise it is saved to the address book displayed in the Address Selector.

You can create new contacts using the New Contact button. This button is not active if you are 
currently displaying the system address book. To create a new contact, click New Contact, enter 
the contact information in the different tabs, then click OK. For more information, see “Managing 
Contacts Through Your Mailbox” on page 58.

To create a routing slip in the item you are creating, click Routing Slip. For more information, see 
“Creating a Routed Item” on page 31.

Where the Address Selector Displays

The Address Selector displays in other places throughout GroupWise, for example, when you are 
selecting members of a group, entries for a filter or find, and so forth. It might be slightly modified 
to show only context-appropriate options.

Contacts Folder

The Contacts folder  in the GroupWise Folder List, by default, represents the Frequent Contacts 
address book in the Address Book. 

If you want the Contacts folder to display entries from a different address book, right-click the 
Contacts folder, click Properties, click the address book name from the Address Book drop-down 
list, then click OK.

Any modification you make in the Contacts folder will also be made in the corresponding address 
book (Frequent Contacts or other address book).

What You Can Do in the Contacts Folder

Use the Contacts folder to view, update, delete, and add information to the contacts in your address 
book. For more information, see “Managing Contacts Through Your Mailbox” on page 58.

System Address Book
The system address book is marked with a  icon.

The system address book is the address book configured and maintained by the system 
administrator. Use this address book to view information about everyone in your GroupWise 
system. 

Because the system address book is generally quite large, you might want to search for names or 
use predefined filters to find the name you are looking for, rather than scrolling through the entire 
address book. See “Searching for User, Resource, Organization, and Group Addresses” on 
page 75.

You can view information about contacts in the system address book, but you cannot edit this 
information.
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Frequent Contacts Address Book
The Frequent Contacts address book is marked with a  icon.

Use the Frequent Contacts address book to access your most frequently used or most recently used 
entries. When you use an address in a message, the entry is copied to the Frequent Contacts address 
book if the book’s options are set to do so. You can view the date and time you last used an entry 
and the number of times you have used it. 

After an entry is placed in Frequent Contacts, it remains there until you delete it. The entry also 
remains in its original address book.

You can use Frequent Contacts Properties to decide which addresses to capture (if any) from either 
received or sent items, and how long you want addresses to remain in the address book before 
deleting them.

Although the Frequent Contacts address book is created by GroupWise, it is considered a personal 
address book because you can edit the information for contacts. 

Personal Address Books
Personal address books are marked with a  icon.

You can create, edit, save, and rename multiple address books for your personal use, and you can 
share these address books with other users.

You can add and delete names and address information for any contact (person, company, or 
resource) you want in your personal address books. You can also create your own information 
properties (fields). When you create a personal address book, a book icon is added to the main 
Address Book window. You can expand and collapse open books by clicking + and -.

When you create multiple address books, you can include the same name and address in several 
books. If the entry is copied from an address book and you edit the entry’s information in one book, 
it is updated in all books.

Personal address books list addresses according to your preferences. For example, you can include 
Internet addresses or no address at all for the people you add to your personal address books. You 
can also create personal groups. If you save a list of people as a group, you only need to type the 
group name in the To box to send the entire group a message. See “Using Groups to Address 
Items” on page 75.

Shared Address Books
Shared address books are marked with a  icon. This icon might be slightly different, depending 
on whether or not you created the address book.

You can share personal address books with other users. You can give users read only rights, or you 
can give them rights to read, add, edit, and delete information in the address book. When you share 
an address book, the users receive a notification that they can accept or decline. See “Sharing an 
Address Book with Another User” on page 81.

Searching for Users and Resources
You can quickly find entries in an address book by using the Search List. You can also specify 
search criteria by defining one or more filters.
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When you begin typing a name in the To, CC, or BC boxes of an item you are creating, Name 
Completion tries to complete the name for you. It searches the address books in the order you 
specify in the Name Completion Search Order dialog box for entries that match what you’re 
typing.

If Name Completion finds the name you are looking for, you can stop typing. If Name Completion 
doesn't find it, continue typing: Name Completion searches again after each new character you 
type. If Name Completion finds a name that is close to but doesn’t exactly match the one you are 
looking for, you can use the Up or Down arrows to scroll to adjacent names in the Address Book. 

You can tell Name Completion to search your address books in a specific order. However, Name 
Completion always searches the system address book last.

This section contains the following topics:

“Searching for User, Resource, Organization, and Group Addresses” on page 75

Searching for User, Resource, Organization, and Group Addresses
1 In the Main Window, click  on the toolbar.

or

Click  on the toolbar in an item you are composing.

2 Select the address book where you want to search for addresses.

3 Begin typing what you are searching for.

Name Completion completes the name.

Using Groups to Address Items
A group is a list of users or resources you can send messages to. Use groups to send a message to 
several users or resources by typing the group name in the To, BC, or CC boxes. There are two 
types of groups: public and personal.

A public group is a list of users created by the system administrator and is available for use by each 
GroupWise user. For example, there might be a public group for the Accounting Department. Each 
employee in Accounting is included in the group. Public groups are listed in the system address 
book.

A personal group is a group created by you. For example, if you often send an appointment to your 
work group, you can include each co-worker’s address or name and a meeting place (a resource) 
in a personal group. 

Groups are marked with the  icon, and are displayed in both the left and right panes of the open 
address book.

This section contains the following topics:

“Creating and Saving a Personal Group” on page 76

“Addressing Items to a Group” on page 76

“Adding and Removing Contacts from a Personal Group” on page 77

“Viewing Group Information” on page 77
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Creating and Saving a Personal Group
1 In the Main Window, click  on the toolbar.

2 Click the personal address book you want to add this group to.

3 Click New on the toolbar, click Group, then click OK.

4 Type a name for the group.

5 Type comments, such as a description of the group.

6 Click Members to open the Address Selector dialog box and display the address list.

7 Click To, CC, or BC, double-click or Ctrl+click and drag the users and resources for your 
group. 

If the users you want to add are in a different address book, click the address book on the Look 
In drop-down list.

To filter the list of entries by contacts, groups, or resources, click an option on the  drop-
down list.

8 To add an entry that is not in an existing address book, click New Contact, fill in the 
information, click OK, then double-click the entry.

9 Click OK twice to save the group in the personal address book.

You can also create and save a personal group from the Address Selector when you are addressing 
a message or other item:

1 In an item view, click  on the toolbar.

2 Double-click contacts to add them to the right pane.

If the users you want to add are in a different address book, click the address book on the Look 
In drop-down list.

To filter the list of entries by contacts, groups, or resources, click an option on the  drop-
down list.

3 To add an entry that is not in an existing address book, click New Contact, fill in the 
information, click OK, then double-click the entry.

4 Click Save Group.

or

If you want to save the group to a different address book than the one that is displayed, click 
the arrow on the right of Save Group, then select the address book.

5 Type a name for the group.

6 Type comments, such as a description of the group.

7 Click OK twice.

Addressing Items to a Group
1 In an item view, click  on the toolbar.

2 Select a group, then click To, CC, or BC.

3 Repeat as necessary.

4 To show all the members of the group, right-click the group, then click Expand Group.
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5 To see more information about the group, right-click the group, then click Details.

6 Click OK to return to the item view.

Adding and Removing Contacts from a Personal Group
1 In the Main Window, click  on the toolbar. In the left pane, click + to expand 

the address book the group is located in, then click the name of the address book.

or

Click  on the toolbar in an item you are composing.

2 Right-click the group, then click Details.

Groups are marked by the  icon and display in the right and left panes of the Address Book.

3 On the Details tab, click Members to open the Address Selector dialog box and display the 
address list.

4 To add a contact, click the Look In drop-down list, then click the address book the contact is 
in.

5 Click the Match drop-down list, then click the way you want to locate the contact (by first 
name, last name, or full name).

6 In the Look For field, type the contact you want to add.

The address list scrolls to the nearest match.

7 Double-click the contact in the list so that it is added to the Selected list.

8 To delete a contact, click the name in the Selected list, then click Remove.

9 Click OK twice to save the group.

Viewing Group Information
1 In the Main Window, click  on the toolbar. In the left pane, click the address 

book where the group is located. Click + to expand the address book.

or

Click  on the toolbar in an item you are composing.

or

Click the Contacts folder  in the Folder list.

2 Right-click the group, then click Details. Groups are marked with the  icon.

3 Click the Details tab.

Printing Lists from the Address Book
You can print addresses in labels or lists from the Address Book.

This section contains the following topics:

“Printing Lists from the Address Book” on page 77
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Printing Lists
1 In the Main Window, click  on the toolbar.

2 Click the address book that contains the entries you want to print.

3 Ctrl+click or Shift+click to select individual entries.

or

Make no selections if you want to print the entire address book.

4 Click File, then click Print.

5 If prompted, click Selected Items.

or

Click Entire Address Book.

6 Make sure the Form tab is selected.

7 Click List in the Format group box.

8 Click what you want to print in the Select Available Print Forms list box.

You can only print information that has been entered in the address book fields. If there is no 
information for a particular field, nothing is printed for that field.

9 Click a paper size in the Form Size group box.

10 Click Portrait or Landscape in the Form Orientation group box.

11 Click the Content tab.

12 Depending on what you selected to print in Step 7, you might be able to select and deselect 
the fields you want to print.

13 Click Preview to see how the list will look.

14 Click Print.

Using the Address Selector and Address Book to Send Messages
Use the Address Selector to address items you are composing. For more information about the 
Address Selector, see “Address Selector” on page 72.

Use Mail to send items from an address book. If you have opened the Address Book from the Main 
Window, the Address Book and GroupWise are not connected. Mail lets you open an item view 
from the Address Book.

This section contains the following topics:

“Using the Address Selector to Address an Item” on page 78

“Sending Mail from the Address Book” on page 79

Using the Address Selector to Address an Item
1 In an item you are composing, click  on the toolbar.

2 Select an address book from the Look In drop-down list.

3 Double-click the names you want as primary (To) recipients of your message.
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4 To address carbon copy recipients, click CC, then double-click the names you want.

5 To address blind copy recipients, click BC, then double-click the names you want.

6 Click the  drop-down list to show only contacts, groups, or resources in your list.

7 Click the Match drop-down list to select how you want to locate a recipient (by name, last 
name, or first name), then type the recipient’s name.

8 Click OK.

If you know the person’s name, begin typing it in the To box of the item view. Name Completion 
searches the Frequent Contacts address book, the current address book, and the system address 
book, provided they are listed in the Name Completion Search Order. When Name Completion 
finds the person you want to send a message to, you can stop typing. If Name Completion finds a 
name that is close to but doesn’t exactly match the one you are looking for, use the Up or Down 
arrows to scroll to adjacent names in the Address Book.

Sending Mail from the Address Book
1 In the Main window, click  on the toolbar.

2 Click an address book.

3 Ctrl+click the users you want to send mail to.

4 Click File, then click Send Mail.

Using Frequent Contacts
Use the Frequent Contacts address book to access your most frequently used or most recently used 
entries. When you use an address in a message, the entry is copied to the Frequent Contacts address 
book if the book’s options are set to do so. You can view the date and time you last used an entry 
and the number of times you have used it. 

After an entry is placed in Frequent Contacts, it remains there until you delete it. The entry also 
remains in its original address book.

You can use Frequent Contacts Properties to decide which addresses to capture (if any) from either 
received or sent items, and how long you want addresses to remain in the address book before 
deleting them.

This section contains the following topic:

“Using Frequent Contacts to Address Items” on page 79

Using Frequent Contacts to Address Items
1 Click  in an item you are composing.

2 Select Frequent Contacts from the Look In drop-down list.

3 Double-click the names you want, then click OK.

The Frequent Contacts address book can be closed, but it cannot be deleted.
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Creating Personal Address Books
You can create, edit, save, and rename multiple address books for your personal use, and you can 
share these address books with other users.

You can add and delete names and address information for any contact (person, company, or 
resource) you want in your personal address books. You can also create your own information 
properties (fields). When you create a personal address book, a book icon is added to the main 
Address Book window. You can expand and collapse open books by clicking + and -.

When you create multiple address books, you can include the same name and address in several 
books. If the entry is copied from an address book and you edit the entry's information in one book, 
it is updated in all books.

Personal address books list addresses according to your preferences. For example, you can include 
Internet addresses or no address at all for the people you add to your personal address books. You 
can also create personal groups. If you save a list of people as a group, you only need to type the 
group name in the To box to send the entire group a message.

This section contains the following topics:

“Creating a Personal Address Book” on page 80

“Deleting a Personal Address Book” on page 80

“Editing a Personal Address Book” on page 81

Creating a Personal Address Book
1 In the Main Window, click  on the toolbar.

2 Click File, then click New Book.

3 Type a name for the new book, then click OK.

4 To add new entries to the new address book, click the address book, then click New on the 
toolbar.

5 Click the Entry Type, then click OK.

6 Fill in the fields for the entry.

For information about the different fields, see “Managing Contacts” on page 59, “Managing 
Groups” on page 60, “Managing Resources” on page 60, and “Managing Organizations” on 
page 60.

7 Click OK.

8 To copy entries to the new address book from existing address books, click the existing 
address book, click an entry, then drag the entry to the new address book.

You can add and modify records in your personal address books. However, only the system 
administrator can add and modify records in the system address book.

Deleting a Personal Address Book
1 In the Main Window, click  on the toolbar.

2 Click File, then click Delete Book.

3 Click or Ctrl+click the books you want to delete, click OK, then click Yes.

After it is deleted, a personal address book cannot be recovered.
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Editing a Personal Address Book
In a personal address book, you can add or delete entries, edit existing information, copy names 
from one book to another, or rename a book. You can also create your own custom address book 
fields.

This section contains the following topics:

“Deleting Entries from a Personal Address Book” on page 81

“Editing Entries in a Personal Address Book” on page 81

“Copying Entries Between Personal Address Books” on page 81

“Renaming a Personal Address Book” on page 81

Deleting Entries from a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Click an address book, then click or Ctrl+click the names you want to remove.

3 Press the Delete key, then click Yes.

Editing Entries in a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Click an address book, then double-click the name you want to edit.

3 Edit the information on the different tabs, then click OK.

Copying Entries Between Personal Address Books

You cannot copy to a closed address book; you must open the book first. You cannot copy names 
to the system address book.

1 In the Main Window, click  on the toolbar.

2 Click an address book, then click or Ctrl+click the names you want to copy.

3 Click Edit, then click Copy To.

4 Select the address book you want to copy the names to, then click OK.

Renaming a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Click the personal address book you want to rename.

You cannot rename the Frequent Contacts address book.

3 Click File, then click Rename Book.

4 Type the new name, then click OK.

Sharing an Address Book with Another User
1 In the Main Window, click  on the toolbar.

2 Right-click the address book you want to share, then click Sharing.

If the address book is not visible, you must open it by clicking File, then clicking Open Book.

3 Click the Shared With radio button.
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4 Type the name of the person with whom you want to share the address book, then click Add 
User.

If you do not know the name of the person, click .

You cannot share address books across external domains.

5 Click each user’s name in the Share List, then assign him or her Access rights in the Access 
group box.

6 Click OK to save your changes and close the Properties dialog box.

When you click OK, the person with whom you want to share the address book receives a 
notification. The Status column displays as Pending until the user accepts or declines the 
shared address book request, then the column is updated to reflect the user's selection.

In the Address Book, shared address books are marked with the  icon.

You and the users you share an address book with can arrange your address book columns 
differently.
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8 Using Caching Mode

Caching mode stores a copy of your network mailbox, including your messages and other 
information, on your local drive. This allows you to use GroupWise® whether or not your network 
or Post Office Agent is available. Because you are not connected to the network all the time, this 
mode cuts down on network traffic and has the best performance. A connection is made 
automatically to retrieve and send new messages. All updates are performed in the background so 
your work is not interrupted. 

You should use this mode if you have enough disk space on your local drive to store your mailbox. 

Several users can set up their Caching Mailboxes on a single shared computer.

If disk space is limited, you can restrict the items that are downloaded to your local mailbox. You 
can specify to get the subject line only or specify a size limit.

Your system administrator can specify settings that do not allow you to use Caching mode or that 
require you to use only Caching mode.

This section contains the following topics:

“Caching Features” on page 83

“Setting Up Your Caching Mailbox” on page 83

“Synchronizing Your Caching Mailbox with Your Online Mailbox” on page 84

“Deleting Items in Your Caching Mailbox” on page 84

“Connection Status” on page 84

Caching Features
Most GroupWise features are available in Caching mode. 

Setting Up Your Caching Mailbox
Setting up a Caching Mailbox requires enough disk space (either on your local hard drive or 
another network drive) to store all the data in your mailbox.

1 Make sure GroupWise is installed on the computer where you want to set up your Caching 
Mailbox.

2 Click File, click Mode, then click Caching.

or

Click Caching on the drop-down list above the Folder List.

3 Type the path for your Caching Mailbox, then click OK.
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4 Make sure you have a password on your Online Mailbox.

GroupWise automatically updates the Caching Mailbox with an image of the Online Mailbox. 
The initial update or “priming” should not be interrupted until it is complete. You will be 
prompted to restart GroupWise to change to the Caching Mode.

After the Caching Mailbox is primed, you may want to run GroupWise in Caching Mode 
without changing modes from Online to Caching.

To run in Caching mode,

5 Click File, click Mode, then click Caching.

or

Click Caching on the drop-down list above the Folder List.

6 You are asked to are asked to restart GroupWise, click Yes.

When GroupWise restarts you are in Caching mode.

You can also open your Mailbox in any mode and select Caching from the Mode drop-down list.

Synchronizing Your Caching Mailbox with Your Online Mailbox
Use the following steps to update or synchronize your Caching Mailbox items, addresses, 
documents, and settings with your Online Mailbox.

1 To synchronize items, click Accounts, then click Send/Retrieve.

Deleting Items in Your Caching Mailbox
In Caching mode, you can delete items, retract items, and empty the Trash the same way you would 
in the Online mode.

1 Click the item in your Mailbox.

2 Click Edit, then click Delete.

3 If you’re deleting an outgoing item, click one of the available options.

4 To free up disk space, click Edit, then click Empty Trash.

This permanently removes all deleted items from your Caching Mailbox.

Changes in your Caching and Online Mailboxes will automatically synchronize.

Connection Status
By default, the Connection Status window is not displayed in Caching mode, but you can display 
it by clicking Account, then clicking Show Status Window.
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9 Working with Documents

The Cross-Platform client is not fully integrated with GroupWise® Document Management 
Services. In the Cross-Platform client, you can perform the following tasks:

List the documents in the Default Library folder.

List the documents in the Authored folder.

Attach a document reference to an outgoing e-mail message.

Receive a document reference on an incoming e-mail message.

Save a document associated with a document reference to disk.

Associate file extensions with OpenOffice programs and open documents from the 
Attachments window.

Search for text in document titles using the Find feature.

In the Cross-Platform client, you cannot perform the following tasks:

Select or change the default library.

Create a new document and add it to a library.

Edit an existing document and return it to a library.

Import documents into a library.

Display properties of a document.

Search for text in the body of a document using the Find feature.
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10 Customizing GroupWise

Use Options to customize GroupWise® by setting defaults that are in effect each time you start 
GroupWise. You can set options that make your work more efficient, change how GroupWise 
looks, and accomplish specific tasks. 

For example, you can use Language Options to change the interface language GroupWise uses, or 
you can use Send Options to specify that you get a return receipt for every message you send. You 
can also use Options to specify an archive folder, and so forth.

This section contains the following topics:

“Requesting a Reply for All Items You Send” on page 87

“Confirming Deletion of Items” on page 88

“Specifying Applications to View Attachments” on page 88

“Specifying Where Archived Items Are Stored” on page 88

“Seeing Time Zones of Other Locales” on page 88

“Calculating a Start or End Date” on page 89

“Changing the Priority of Items You Send” on page 89

“Setting Printing Options” on page 89

“Changing the GroupWise Interface Language” on page 90

“Setting a Default Web Browser” on page 90

“Using Startup Options” on page 90

Requesting a Reply for All Items You Send
1 To request a reply for one item, open an item view, click the Send Options tab, then click 

General.

or

To request a reply for all items you send, click Tools, click Options, then click Send.

2 Click Reply Requested, then specify when you want to receive the reply.

The recipient sees  next to the message. If you select When Convenient, “Reply Requested: 
When convenient” appears at the top of the message. If you select Within x Days, “Reply 
Requested: By xx/xx/xx” appears at the top of the message.

3 Click Send.
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Confirming Deletion of Items
Use Item Deletion Confirmation to have GroupWise prompt you for confirmation each time you 
delete an item.

1 Click Tools > Options.

or

In Macintosh, click GroupWise > Preferences.

2 Click General.

3 Select the Item Deletion Confirmation check box, then click OK or Apply.

Specifying Applications to View Attachments
Use Extension to specify the application to use when viewing attachments of a particular file type. 
When you receive an attachment, GroupWise attempts to open the application associated with the 
attachment’s extension. 

1 Click Tools > Options.

or

In Macintosh, click GroupWise > Preferences.

2 Click Extension.

3 Click Add to add a viewer application for particular kinds of files. Type the path and name of 
the external application, or browse to its location. Type the file extension (such as .txt or .doc, 
with no leading dot) in the Extensions box. Click OK.

4 Click Use Application to Open Other Files to use the system default application to open other 
file types. If you want to use another application, click Custom Application, then type the path 
of the application.

Specifying Where Archived Items Are Stored 
1 Click Tools > Options.

or

In Macintosh, click GroupWise > Preferences.

2 Click General.

3 Specify the location of your archive directory in the Archive Directory text box.

4 Click OK.

Seeing Time Zones of Other Locales
Use Time Zone Difference to see the time zone in one locale based on the time zone in another. 
For example, if you are in New York, you can use Time Zone Difference to see the time in London.

1 Click Tools > Time Difference.

2 In the Time Zone A box, select the time zone of the originating time zone.

3 In the Time Zone B box, select the time zone of the destination time zone.

4 When you are finished, click Close.
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Calculating a Start or End Date
You can calculate a starting or ending date based on a given date and a specified number of days. 
For example, you might have a deadline 90 days after a certain action. Date Difference lets you 
calculate the date the deadline will fall on.

1 Click Tools > Date Difference.

2 To calculate a start date when you know the end date, click the arrow buttons to move forward 
or backward one month or year at a time in the End Date group box, then click a date.

or

To calculate an end date when you know the start date, use the arrow buttons to move forward 
or backward one month or one year at a time in the Start Date group box, then click a date.

3 Type a number in the Number of Days Different text box.

4 Click Calculate Start Date, then view the calculated start date in the Start Date text box and 
calendar.

or

Click Calculate End Date, then view the calculated end date in the End Date text box and 
calendar. 

Changing the Priority of Items You Send
1 To change the priority of one item, open an item view, click the Send Options tab, then click 

General.

or

To change the priority of all items you send, click Tools, click Options, then click Send. 

2  Select High Priority, Standard Priority, or Low Priority.

The small icon next to an item in the Mailbox is red when the priority is high, white when the 
priority is standard, and gray when the priority is low.

3 Click OK.

Setting Printing Options
Use Print Options to set the appearance for printed messages, calendars, and address books.

1 Click Tools > Options.

or

In Macintosh, click GroupWise > Preferences.

2 Click Printing.

3 Click the General tab, select the Print Page Number check box to print the page number of the 
item, and click the … button to the right of the Header, Subheader, and Plain Text printing font 
boxes to modify the font selections. Click Page Setup to format the printed page to your 
specifications.

4 To set Message printing options, click the Message tab, then select the check boxes of the 
message components you want to print.
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5 To set Calendar printing options, click the Calendar tab, select the number of days to be 
printed on the calendar, then click the items and components you want to print.

6 To set Address Book printing options, select the address book columns you want to print, then 
select the size of the printed area (in rows and columns).

7 Click OK or Apply.

Changing the GroupWise Interface Language
1 Click Tools > Options.

or

In Macintosh, click GroupWise > Preferences.

2 Click General. 

3 Select a language in the Interface Language drop-down list, then click OK.

Setting a Default Web Browser
The default Web browser is the browser used to open Web links found in messages.

1 Click Tools > Options.

or

In Macintosh, click GroupWise > Preferences.

2 Click General.

3 In the Default Web Browser box, type the path to your Web browser.

In Linux, the browser is typically located in the /opt/browser/ directory.

4 Click OK.

Using Startup Options
GroupWise has commands that you can use when you start the Cross-Platform client on Linux. 
Some of them are for your convenience, and others are necessary to run GroupWise on your 
particular hardware. 
NOTE: Startup options are not used with the Cross-Platform client on Macintosh.

GroupWise Startup Options on Linux

This Startup Option Does This

-@u=? Displays a login dialog box whenever you open GroupWise, 
allowing you to supply any necessary login information.

 -@u=user_ID Lets you use your GroupWise user ID to open GroupWise as 
yourself on another user's computer. The other user remains 
logged on to the network.

-ipa=ip_address_or_hostname Lets you specify the IP address (x.x.x.x) or the name of the IP 
address when you are running in client/server mode.
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GroupWise Language Codes

The following table lists the languages the GroupWise client has been localized into for 
GroupWise 5.5 and later versions. Some versions might not include all of these languages. For the 
most current information, see your local reseller.

-ipp=port_number Lets you specify the IP port when you are running in client/server 
mode. 

-l=xx Applies only if you have two or more language versions or 
language modules. This option instructs GroupWise to override the 
default environment language (under General Environment in 
Options) with the language specified by the language code (xx). 
The language codes are listed in the table below.

-a=network_ID Lets you log on to another user’s computer using your network ID. 
The other user remains logged on to the network.

-nu Turns off AutoRefresh. If this option is selected, click View, then 
click Refresh whenever you want to update the display with the 
items currently in your Mailbox.

-ph=pathname Lets you specify the path to the post office.

-pc=path_to_caching_mailbox Opens GroupWise in Caching mode. GroupWise must be 
restarted when you change from Online to Caching.

Language Language Code

Arabic AR 

Chinese Simplified CS

Chinese Traditional CT

Czech CZ

Danish DK

Dutch NL

English US

Finnish SU

French FR

German DE

Hebrew HE

Hungarian HU

Italian IT

Japanese JP

Korean KR

This Startup Option Does This
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Using a GroupWise Startup Option
1 Right-click the GroupWise icon on the desktop, then click Properties. 

2 Click the Execute tab. 

3 In the Command text box after the GroupWise executable name, type a space, type the startup 
options, then click OK.

Separate multiple startup options with a space, like this:

/opt/novell/groupwise/client/bin/groupwise -p pathname -@u=?

In this example, -ph is the startup option to specify the path to the post office. The pathname 
is the path to the post office. The -@u=? option is used to display a login dialog box a user 
can supply with login information whenever he or she opens GroupWise. This option is useful 
when two or more users share a workstation but have separate GroupWise Mailboxes.

4 Restart GroupWise. 

Norwegian NO

Polish PL

Portuguese BR

Russian RU

Spanish ES 

Swedish SV

Language Language Code
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11 GroupWise Frequently Asked Questions

The GroupWise 6.5 Client Frequently Asked Questions (FAQ) is intended to help GroupWise 
client users who have not found the information they need in the GroupWise client online help or 
User Guides.

The GroupWise 6.5 Client Frequently Asked Questions (FAQ) contains the following sections:

“How Do I Find What I Need in the GroupWise Client Documentation?”

“GroupWise Windows Client FAQ”

“GroupWise Cross-Platform Client FAQ”

“GroupWise WebAccess Client FAQ”

“Non-GroupWise Clients FAQ”

“GroupWise Client Comparison”

“Where Do I Go for More Help?”
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A Documentation Updates

This section lists updates to the GroupWise 6.5 Cross-Platform Client User Guide that have been 
made since the initial release of GroupWise® 6.5. The information will help you to keep current 
on documentation updates and, in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the GroupWise 6.5 Cross-Platform Client 
User Guide was republished.

The GroupWise 6.5 Cross-Platform Client User Guide has been updated on the following dates:

“September 19, 2005 (GroupWise 6.5 SP5)” on page 95

“February 28, 2005” on page 96

“October 20, 2004” on page 96

September 19, 2005 (GroupWise 6.5 SP5)

Location Update

“Cabinet Folder” on page 15 Added information on what the cabinet folder is used for.

“Logging in to Your Mailbox 
from a Shared Workstation” 
on page 24

Added a section on how to log in to GroupWise from a shared 
workstation.

“Adding a Signature or 
vCard to Items” on page 30

Added instructions for adding a signature to an item in Macintosh.

“Rescheduling Recurring 
Appointments” on page 44

Added a section on how to reschedule recurring appointments.

Chapter 5, “Using Your 
Calendar,” on page 51

Added a paragraph explaining that items that are archived are no 
longer displayed on the calendar.

Chapter 6, “Managing Your 
Mailbox,” on page 55

Added a paragraph explaining that items that are archived are no 
longer displayed on the calendar.

“Unarchiving Items” on 
page 62

Added information about what happens when you are working on a 
computer where archiving is not available.

Chapter 11, “GroupWise 
Frequently Asked 
Questions,” on page 93

Added a section on how to access the GroupWise Frequently Asked 
Questions document.
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February 28, 2005
The following updates were made to the GroupWise 6.5 Cross-Plaatform Client User Guide in 
February 2005:

October 20, 2004
The following updates were made to the GroupWise 6.5 Cross-Plaatform Client User Guide in 
October 2004:

Location Update

Chapter 2, “Logging In to 
GroupWise,” on page 23

Added a = to the -@u ? command.

Chapter 10, “Customizing 
GroupWise,” on page 87

Added a = to all startup options on Linux.

Location Update

Chapter 4, “Sending Instant 
Messages, on page 43

Removed and created separate GroupWise Messenger User Guide.

Added a chapter comparing the GroupWise clients.
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